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1 PREFACE 

The Bruker Compass QuantAnalysis 2.0 application (referred to as ‘QuantAnalysis’) is 
the state-of-art Windows XP application for quantitation of analyses acquired on Bruker 
Daltonics mass spectrometer instruments. QuantAnalysis is specifically designed to 
process analyses acquired on the esquire/HCT ion trap, the micrOTOF ESI time-of-
flight and the APEX FTMS mass spectrometers. 

QuantAnalysis is an advanced program dedicated for quantitation of MS and MSn 
analyses. Dynamically linked views of the spreadsheet data, the chromatogram and 
spectrum, and the calibration curve make quantitation faster and easier. A change in 
any of the views, e.g., selecting a different curve fit for calibration, is immediately 
reflected in all other views. QuantAnalysis processes batches acquired with Bruker 
Compass HyStar or Agilent ChemStation. Printed reports in various layouts are avail-
able and custom layouts can be created using the Bruker Compass ReportDesigner. 

 
The QuantAnalysis User Manual describes how to work with QuantAnalysis 2.0. For 
reference on QuantAnalysis 2.0 menus and commands, please refer to the Quant-
Analysis Reference Manual that is available as PDF document with your installation. 
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2 GETTING STARTED 

2.1 Installing and Uninstalling QuantAnalysis 

The QuantAnalysis 2.0 application installs automatically when the Bruker Compass 
DataAnalysis 4.0 application is installed on your system. The QuantAnalysis application 
is uninstalled automatically when you uninstall the DataAnalysis application from your 
system. 

To work with QuantAnalysis, a valid 'ESI Compass 1.3' license must be present.  
 

2.2 Compliance Mode and UserManagement 

2.2.1 Running QuantAnalysis in Compliance or Non-
Compliance Mode 

QuantAnalysis can be run in ‘Compliance’ or ‘Non-Compliance’ mode. Working in 
Compliance mode can support you to meet FDA 21 CFR Part 11 (FDA’s rule on elec-
tronic signatures and records) requirements.  

To run QuantAnalysis in Compliance mode, the Bruker Daltonics Compass Security 
Pack application providing Bruker Daltonics UserManagement needs to be installed 
either on this computer or, preferably, on a central server. When the ‘Compass Security 
Pack’ license is present, QuantAnalysis runs in Compliance mode automatically. 
Otherwise, QuantAnalysis runs in Non-Compliance mode. 

Note: Compliance mode in the context of Compass Security Pack exclusively means 
the availability of Compass Security Pack tools and functionalities, which can be 
used to support the user to meet 21 CFR Part 11 requirements. Neither Com-
pliance mode nor Compass Security Pack can assure full compliance with 21 
CFR Part 11 requirements. 

Compliance mode 
The Compliance mode for QuantAnalysis offers the following features: 
• Only operators created by the customer’s UserManagement administrator can log 

into QuantAnalysis after identification by operator ID and password. 
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• The UserManagement administrator can administer access to QuantAnalysis by 
assigning individual rights to the operators he creates. These rights determine the 
actions the operator is allowed to perform in QuantAnalysis. 

• Electronic signatures for signing electronic records are possible. Multiple signing of 
results is allowed. 

• All Bruker Daltonics applications installed on the operator’s computer can be locked 
and unlocked by the operator. 

Note: Most of the features above apply to any application supported by the Bruker 
Daltonics UserManagement. 

Non-Compliance mode 
When QuantAnalysis is running in Non-Compliance mode: 
• Anybody can log into QuantAnalysis because no identification by operator ID and 

password is needed.  
• Operators who have different QuantAnalysis rights do not exist. 
• QuantAnalysis and other Bruker Daltonics applications cannot be locked or unlocked. 
 

2.2.2 Bruker Daltonics UserManagement 

QuantAnalysis uses the Bruker Daltonics UserManagement application to run in Com-
pliance mode.  

UserManagement enables you to administer access to Bruker Daltonics applications 
and manage individual action rights based on operator’s ID and password. Operators 
are created and assigned rights using the Bruker Daltonics UserManagement Admini-
stration Tool application. The customer’s UserManagement default administrator and 
perhaps further UserManagement administrators (if they have the ‘UserManagement 
Administration Tool: Administrate Operators’ right) have the right to determine who can 
use QuantAnalysis and assign individual rights to them determining the actions these 
operators are allowed to perform in QuantAnalysis. 

Before anybody apart from the UserManagement default administrator can log into 
QuantAnalysis when in Compliance mode, the UserManagement administrator has to 
create (an) desired operator(s) identified by operator ID and password. To become 
effective an operator must be assigned to an operator group that has specific rights. 
The UserManagement administrator can use the auto-generated operator groups or 
define new groups to be able to customize the assignments of rights based on specific 
requirements. All members within a group will have the same rights. The UserManage-
ment administrator can also modify the default password policy and timeout settings as 
desired. 
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Note: For detailed information on how to create operators and assign rights, please 
refer to the UserManagement help tools. 

 
UserManagement is client-server based. On the server PC the database defining 
operators and their rights is installed, on the client PC the Bruker Daltonics applications 
are installed. 
 

2.2.2.1 QuantAnalysis Operating Rights in UserManagement 

Specific rights for performing actions in QuantAnalysis are recorded in UserManage-
ment. These rights can be assigned to an operator group and, therefore, to an opera-
tor. If an operator tries to perform an action without having the respective right, an error 
message appears. 

The rights existing in QuantAnalysis are listed below. In most cases, several actions 
are associated with a single right, which an operator having this right is allowed to per-
form in QuantAnalysis. An operator must at least have the Load/edit batches right to 
be able to load and edit batch files in QuantAnalysis. 

Right: Actions permitted concerning the following subjects:  

• Change parameter Changing quantitation method parameters and calibration 
curve parameters. 

• Delete result Deleting a result. 

• Load method Loading quantitation methods. 

• Load/edit batches Opening and editing batch files. 

• Process batch Processing batch files using defined routines. 
(Includes e.g. Process, Clear Areas, Delete Peak)  

• Process batch manu-
ally 

Processing batch files manually. (Includes manually inte-
grating and deleting compound peaks)  

• Save batch Saving processed batch files. 

• Save method  Saving quantitation methods. 

 

2.2.2.2 Auto-Generated Operator Groups and Their Right Assignments 
in QuantAnalysis 

In UserManagement various auto-generated operator groups are predefined and each 
includes specific rights for performing actions in QuantAnalysis. The UserManagement 
administrator can assign a new operator to one of these auto-generated groups if he 
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does not want to define own groups. The administrator cannot change the group’s right 
assignment. 

The following operator groups are predefined in UserManagement: 
• Administrators (auto-generated) 
• Operators (auto-generated) 
• Project Managers (auto-generated) 
• Scientists (auto-generated) 
• Service (auto-generated) 
 
The QuantAnalysis rights assigned to the auto-generated operator groups are shown 
below (the figures show the respective sections in the UserManagement Administration 
Tool).  
 ‘Administrator’ ‘Project Manager’ 

  

‘Scientist’ ‘Operator’ 

   
Figure 2-1 QuantAnalysis right assignments of predefined operator groups 

No difference exists between an operator of the ‘Administrators (auto-generated)’ and 
the ‘Project Managers (auto-generated)’ group; both have all rights that are available 
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for this application. An operator of the ‘Scientists (auto-generated)’ group lacks the 
Change parameter, Delete result and Load method rights. An operator of the 
‘Operators (auto-generated)’ group also lacks the Process batch manually right. The 
‘Service’ group is used for service purposes of the manufacturer. 
 

2.2.3 Electronic Records and Electronic Signatures 

When QuantAnalysis is running in Compliance mode, an electronic record (= result of a 
batch file with corresponding method) can be signed electronically by operators who 
have the right to sign. An electronic signature consists of operator ID and password. 
Optionally, the meaning of signing can be given, and multiple signing of results is 
allowed. 

Signing a result is done using the History command found in the Work Table window. 
You can see whether the results of a batch have already been signed by seeing the 
batch’s result history displayed in the Result History or the Open dialog. 
 

2.3 Audit Trailing 

A corresponding audit trail is recorded for each batch file that is set up. The audit trail 
lists all changes that were made to the loaded batch file with corresponding date and 
time, name of the operator who made the change and what was the change. This 
includes all changes saved during previous processing operations performed on this 
batch file and changes made during the current processing of this batch file, even if 
these changes have not been saved yet. When the batch file is closed only changes 
actually saved during the processing are stored in the audit trail. 

You can view the audit trail of the loaded batch file using the Show Audit command 
found in the Work Table window. 
 

2.4 Starting QuantAnalysis 

You can start QuantAnalysis from the Windows Start menu. During installation of the 
Bruker Daltonics applications package, a Bruker Daltonics folder was created auto-
matically in the Start menu’s Programs folder. This folder contains the respective 
applications. You can also start QuantAnalysis via Windows Explorer by double-click-
ing an existing batch file (*.btc). This automatically starts QuantAnalysis and opens the 
selected batch file. 



Getting Started Bruker Daltonik GmbH 

 QuantAnalysis User Manual, Version 2.0 2-6 

On starting QuantAnalysis, a dialog appears that requests you to log in unless you are 
already logged in another Bruker Daltonics application (for both Compliance and Non-
Compliance mode) or the corresponding option for skipping this dialog is set (for Non-
Compliance mode only). 

After logging in, QuantAnalysis starts and the user interface displayed depends on the 
settings stored for the current user logged into Windows. 

To start QuantAnalysis via the Windows Start menu: 

1. Click . 
2. Click Programs. 
3. Click Bruker Daltonics. 
4. Click QuantAnalysis. This starts QuantAnalysis and opens the QuantAnalysis 

dialog. 

  
5. Log in if requested. 
 
To start QuantAnalysis via Windows Explorer with opening the selected batch 
file: 
1. Start Windows Explorer. 
2. Navigate to the batch file you want to open. 
3. Double-click the batch file. This starts QuantAnalysis and opens the QuantAnaly-

sis dialog. 
4. Log in if requested. 
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2.5 Logging an Operator into QuantAnalysis 

When QuantAnalysis is running in Compliance mode, only operators created by the 
UserManagement administrator can log into QuantAnalysis (after being identified by 
their operator ID and password). UserManagement can lock an operator who enters 
the wrong password successively. The UserManagement administrator defines the 
maximum number of allowed false attempts. 
When QuantAnalysis is running in Non-Compliance mode, any operator can log in after 
entering the operator ID. Identification by password is not required.  
Note: Only one operator can be logged into Bruker Daltonics applications on a speci-

fic computer at a time. 
You must log in after starting QuantAnalysis unless you are currently logged in another 
Bruker Daltonics application (for both Non-Compliance and Compliance mode). When 
QuantAnalysis is running in Non-Compliance mode an option for automatic log in of the 
specified operator can be set. 
In Compliance mode, if QuantAnalysis is the first Bruker Daltonics application into 
which you want to log after the UserManagement administrator has defined you as a 
new operator, you will be required to change your password. 
The operator currently logged in is identified in the status bar when QuantAnalysis is 
running. 

To log into QuantAnalysis: 
1. Start QuantAnalysis or when in a running session select Operator from the Help 

menu. This opens the QuantAnalysis dialog that corresponds to the current mode 
in which QuantAnalysis is running. 

2. In Operator, enter your operator ID. The operator ID is not case-sensitive. 
3. In Non-Compliance mode, check Always log in using this operator if you want to 

log in automatically the next time without showing the login dialog again. 
4. In Compliance mode, enter your password in Password. 

Note: Passwords are case-sensitive. (Be careful, entering the wrong password 
successively will cause locking.) 

5. Click Log On. In Compliance mode, log in will be successful only if operator ID and 
password are correct. 

6. If you are required to change your password, change it using the Change Pass-
word dialog and then repeat steps 4 and 5. 
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2.6 Changing the Operator's Password 

When QuantAnalysis is running in Compliance mode, any operator who wants to log in 
has to identify by password. The program requires you to change your password when 
you first log into a Bruker Daltonics application supporting UserManagement after the 
UserManagement administrator has defined you as new operator. You must also 
change your password after the administrator has changed your password or forced a 
password change on you. Apart from this, you can change your password as desired 
either during login or while running a QuantAnalysis session. 

A new password must conform to the password policy settings defined by the User-
Management administrator; or the password will not be changed. 

To change an operator’s password: 
1. Start QuantAnalysis or when in a running session, select Operator from the Help 

menu. This opens the QuantAnalysis dialog. 
2. In Operator, enter your operator ID. 
3. Click Change Password. This opens the Change Password dialog. 
4. In Operator, the ID of the operator whose password can be changed is given. If 

the password for another operator should be changed, click Cancel to return to the 
QuantAnalysis dialog and repeat steps 2 and 3. 

5. In Old password, enter your current password. The password is not displayed as 
you type it. 
Note: Passwords are case-sensitive. 

6. In New password, enter the new password. The new password must conform to 
the password policy settings. 

7. In Confirm new password, enter your new password again. 
8. Close the message confirming a successful password change. If an error mes-

sage appears, repeat the corresponding steps. 
 

2.7 Locking and Unlocking an Operator 

An operator can be locked by UserManagement after too many wrong passwords are 
entered in succession. The UserManagement administrator defines how many wrong 
inputs are allowed. An operator can also be locked by direct UserManagement admi-
nistrator action. The operator will get information about being locked after locking has 
occurred. 

A locked operator cannot log into any Bruker Daltonics application supporting User-
Management. Only the UserManagement administrator can unlock a locked operator. 
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2.8 Locking and Unlocking QuantAnalysis and 
Other Bruker Daltonics Applications 

When QuantAnalysis is running in Compliance mode, you can lock QuantAnalysis and 
all other Bruker Daltonics applications supporting UserManagement installed on your 
system. Only the previous operator or someone with the special right to unlock applica-
tions is permitted to unlock a locked application. 

Note: The Lock All Applications command is available only when QuantAnalysis is 
running in Compliance mode. 

Note: All UserManagement-using Bruker Daltonics applications will be locked automa-
tically if one of these applications has not been used for a certain period as 
defined by the UserManagement administrator. 

 

To lock all Bruker Daltonics applications: 

1. Click  or press the Ctrl+Alt+K keys. Or from the Help menu, select Lock All 
Applications. This opens the QuantAnalysis dialog that informs you that Quant-
Analysis is currently locked and how it can be unlocked. 

 
To unlock all Bruker Daltonics applications: 
1. In the QuantAnalysis dialog, enter in Operator your operator ID. The dialog dis-

plays the name of the previous operator who has locked Bruker Daltonics appli-
cations.The respective ID will automatically be entered if the UserManagement 
administrator has set the corresponding option. 
Anyone other than the previous operator who wants to unlock the applications 
must enter their operator ID.  
Note: To do this, the operator must have the right to unlock applications. 

2. If you want to change the password before logging in, click Change Password 
and change it as instructed. 

3. In Password, enter the password for the operator named in Operator. 
Note: Passwords are case-sensitive. (Be careful, entering the wrong password 

successively will cause locking). 
4. Click Log On. If operator ID and password are correct and if the respective opera-

tor is allowed to unlock applications, QuantAnalysis is unlocked and the respective 
operator is logged in. 
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2.9 Closing QuantAnalysis 

You can close QuantAnalysis when you have finished your current session. On closing, 
the current user interface settings are stored automatically for the current user logged 
into Windows. 
 
To close QuantAnalysis: 

1. Click the application's Close  or select Exit from the File menu. 
2. If required, answer the appearing confirmation request on saving the current proc-

essing state of the open file. 
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3 QUANTANALYSIS USER INTERFACE 

The QuantAnalysis graphical user interface consists of the title bar, the menu bar, the 
toolbar, the status bar and three display windows; the Work Table window, the Chro-
matogram/Spectrum window and the Calibration window. These elements are used for 
displaying and processing the quantitation data and results currently available for the 
open batch file. When QuantAnalysis is running in Compliance mode, the status bar 
displays the full name of the current operator. 
 

 

Figure 3-1 QuantAnalysis user interface in Nested display mode showing the quan-
titation results of the loaded, processed batch file in the Work Table win-
dow, Chromatogram/ Spectrum window and Calibration window  

You can display the three windows individually or nested together to provide four dif-
ferent display modes that you can toggle among by clicking the corresponding Nested, 
Work Table, Chromatogram/Spectrum or Calibration tabs in the lower left corner of 
the QuantAnalysis window. 

The contents of the three windows are linked dynamically. Changes made in one win-
dow are instantly updated in the other windows. For example: if you select another type 



QuantAnalysis User Interface Bruker Daltonik GmbH 

 QuantAnalysis User Manual, Version 2.0 3-2 

of calibration curve in the Calibration window, then that calibration curve is recalculated 
and redisplayed as well as all corresponding quantitation results listed in the Work 
Table window. This allows you to adjust parameters, or corrections like manual integra-
tion of single peaks, quickly and easily. 
 

3.1 Work Table Window 

The Work Table window displays the current Work Table and information on the target 
and ISTD compounds used in quantitating the open batch file. It contains buttons for 
customizing the Work Table layout and for processing the current Work Table contents. 
It also provides buttons for performing the quantitation. 
 

 
Figure 3-2 Work Table window displaying data from a processed batch file 

Work Table 
The Work Table contains all the information that is associated with quantitating a batch 
of samples. By defining and saving this table you create the batch file (*.btc) that pro-
vides easy access to the complete series of files you may later use to review the 
results or to reprocess them. 
The Work Table has two major areas indicated by either dark gray or light gray column 
headers. You can adjust the Work Table layout to specific quantitation tasks. Thus, the 
columns that are displayed depend on the loaded Work Table layout and/or the current 
user settings. 
Sample-specific columns 
The dark gray-headed columns are used to enter sample-specific data.  
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File Name. File name of the analysis acquired for the respective sample. 
Sample Name. Name of the sample. 
Sample Info. Information on the sample. 
Vial. Number of the vial the sample was placed in. 
Method Name. Name of the quantitation method to be used for the file. It must be 

given for each file and it must be the same for all files within a batch of files. 
Inj. Vol. Injected volume of the sample. The value cannot be zero. 
Dil. Factor. Dilution factor used for the sample. The value cannot be zero (e.g. just use 

"1" for all samples). 
Sample Type. Type of the sample. Each sample must be defined by selecting the 

desired sample type from the corresponding drop-down list: 
Sample. (Default) Sample to be quantified. 

Calib. Sample to be used for setting up a calibration curve. 
QC. Sample to be used in quality control for validation of a calibration curve. 
Blank. Blank sample. 

Calib. Level. Calibration level of the sample. This must be defined only for 'Calib' and 
'QC' samples. 'Sample' and 'Blank' samples do not get a calibration level. Quant-
Analysis uses this level to read the corresponding concentration from the table 
defined in the quantitation method used. The calibration level can be given in arbi-
trary numbers (e.g. 1, 2, 3, ...) or as text in the case of 'QC' samples (e.g. low, 
medium, high).  

Inj. No. Injection number. This value cannot be zero. 
Calib. Action. Calibration action to be carried out. This must be defined for each 'Calib' 

sample by selecting the desired action from the corresponding drop-down list. For 
all other sample types enter a hyphen,'-', which is the default setting. 
New. Adds an additional calibration point to the calibration curve. 
Replace. Deletes an already existing calibration point of the respective calibration 
level and replaces it. This applies to multiple injections of a sample. 

Acq. Date. Acquisition date. 
Operator. Name of the operator. 

Compound- and sample-specific columns 
The light gray-headed columns are used to enter compound- and sample-specific data 
needed for performing the quantitation as well as to display the quantitation results. In 
the case of a multi-component calibration, each of these columns exists multiple times, 
one time for each compound. The target compound whose data are currently displayed 
is indicated in the Cmpd list box found above the table. 
Theor. Conc. Theoretical concentration of the target compound in the sample if it is a 

'Calib' or 'QC' sample. If this column is left blank, the QuantAnalysis software 
enters the corresponding values defined in the quantitation method used during 
processing of the batch file. 
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Theor. Conc. Unit. Unit of the theoretical concentration of the target compound in the 
sample if it is a 'Calib' or 'QC' sample. If this column is left blank, the QuantAnaly-
sis software enters the corresponding values defined in the quantitation method 
used during processing of the batch file. 

Conc. ISTD. Concentration of the internal standard in the sample. 
Conc. ISTD Unit. Unit of the internal standard in the sample. 
RT Target Cmpd. Retention time of the target compound in the sample. 
Area Target Cmpd (or Height Target Cmpd). Calculated peak area (or height) of the 

target compound in the sample. Whether peak area or peak height is calculated 
depends on the selected calibration mode ('Area' or 'Height'). 

S/N Target Cmpd. Signal-to-noise ratio of the target compound. 
Area ISTD Cmpd (or Height ISTD Cmpd). Calculated peak area (or peak height) of 

the internal standard in the sample. Whether peak area or peak height is calcu-
lated depends on the selected calibration mode ('Area' or 'Height'). 

S/N ISTD Cmpd. Signal-to-noise ratio of the ISTD compound. 
Ratio Area Target/ISTD (or Ratio Height Target/ISTD). Ratio between the peak area 

(or peak height) of the target compound and the peak area (or peak height) of the 
internal standard in the sample. Whether the ratio between peak areas or peak 
heights is calculated depends on the selected calibration mode ('Area' or 'Height'). 

Calc. Conc. Calculated concentration of the target compound in the sample. 
Note: An ‘n/c’ (= not calculated) will be entered if no concentration value could be 

assigned to the calculated peak area (or height) because there is not data 
point in the calibration curve that fits this area or height value. This may 
happen with quadratic calibration curves only. 

Calc. Conc. Unit. Unit of the calculated concentration of the indicated target com-
pound in the respective sample. 

Accuracy. Calculated accuracy determined as the ratio between the calculated con-
centration (evaluation of the peak area against the current calibration curve) of the 
indicated target compound and its (known) theoretical concentration. It will be cal-
culated only for 'Calib' and 'QC' samples. This value allows you to assess easily 
the quality of the integration results and calibration curve. 

Target and ISTD compound fields 
Cmpd. Displays the active target compound whose corresponding data is currently 

shown in the Work Table. In the case of a multi-component calibration, you can 
click  to display the complete list of target compounds used and switch to 
another compound by selecting it from this list. 

Chro. Displays the chromatogram trace to be used for the active compound in peak 
integration. 

ISTD. Displays the ISTD compound used. If no internal standard is used in the respec-
tive batch file, '<None>' is displayed. 
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Chro. Displays the chromatogram trace to be used for the ISTD compound in peak 
integration.  

Calib. Mode. Displays the currently active calibration mode. Two modes are available: 
Area. This uses the calculated area of a target or ISTD compound peak. 
Height. This uses the calculated height of a target or ISTD compound peak. 

'Work Table layout' buttons 

 Opens the Select Work Table Layout dialog to select a layout. 

 Opens the Save Work Table Layout dialog to save the current layout. 

 Lists the currently hidden Work Table columns and redisplays the 
selected column. 

 Hides the selected column(s). 

'Work Table contents processing' buttons 

 Resets the Work Table to the situation that existed before processing the 
batch. This allows all Work Table fields to be editable again. This allows 
you to remove incorrect entries from fields that otherwise cannot be edited 
after batch processing was performed. 

 Deletes the selected row(s). 

 Plots the data contained in the selected column. This function is only 
available for certain columns. 

‘Showing batch information’ buttons 

 Opens the Audit Trail dialog for the open batch file. 

 Opens the Result History dialog for the open batch file. 

'Importing and exporting' buttons 

 Opens the Import Sample Table dialog to import a sample table. 

 Opens the Save Sample Table dialog to export the batch file to a Comma 
Separated Values (*.csv) file. For a processed batch file its results table 
will be exported; otherwise, the respective sample table file will be 
exported. 

'Quantitation task flow' buttons: 

 Opens the Open Batch dialog to open a batch file. 

 Starts the Method Editor to create the quantitation method to be used with 
opening the General dialog.  
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 Processes the open batch file. 

 Saves the open batch file. If the respective batch has not been saved 
before the Save Batch dialog is opened.  

 Opens the Print dialog to select the desired report layout and to set up 
and print the selected report.  

'Toggling between files' buttons 

     
Toggles to the previous or to the next data file contained in the open batch file and dis-
plays the results corresponding to the currently selected target compound. 

'Toggling between target compounds' buttons 

     
Toggles in the case of a multi-component calibration to the previous or to the next tar-
get compound in the compound list of the currently selected data file and displays the 
corresponding data. 

 

3.2 Chromatogram/Spectrum Window 

After you have performed a quantitation, the Chromatogram/Spectrum window displays 
the individual compound peaks and the corresponding averaged mass spectra calcu-
lated for the target and ISTD compounds contained in the processed data files. Chro-
matogram traces display in the Chromatogram view (above) and mass spectra display 
in the Spectrum view (below). 

You can browse through the results for all files and compounds. If compound peaks are 
not recognized during the quantitation process or are not properly integrated, then the 
integration can be corrected by means of the manual integration mode. This mode 
allows you to reintegrate easily and individually each compound peak without having to 
reprocess the entire batch of files. 

Chromatogram view 
The Chromatogram view displays the chromatogram trace edited from the active data 
file for the active target compound. If an ISTD compound is contained, its correspond-
ing trace will be displayed. If during the automatic integration process the correspond-
ing compound peak(s) has/have been recognized, this/these become(s) labeled with 
an index. You can adjust the display range of the Chromatogram view. 
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If a compound peak has not been recognized during automatic integration, you can 
switch to the manual integration mode to manually integrate the respective peak in the 
Chromatogram view. 
 

  
Figure 3-3 Chromatogram/Spectrum window after performing a quantitation: The 

Chromatogram view displays a recognized target compound peak, the 
Spectrum view the corresponding averaged mass spectrum 

Spectrum view 
The Spectrum view displays the averaged mass spectrum calculated for that peak that 
has been detected for the selected target compound or the ISTD compound. Which 
mass spectrum currently is displayed depends on the selected option (Target or ISTD).  
You can adjust the display range of the Spectrum view. 

File Name 
Displays the name of the currently active data file whose chromatogram and mass 
spectrum data are displayed in the Chromatogram and Spectrum views. This file is 
highlighted in dark green in the Work Table. You can toggle between the different data 
files of a batch using the Prev. File and Next File buttons. 
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Analysis 
Displays analysis data corresponding to the active data file.  

Name. Sample Name as entered in the Sample Name column of the Work Table. 
Desc. Sample description as entered in the Sample Info column of the Work Table. 
Type. Sample type as selected in the Sample Type column of the Work Table.  

Target Compound 
Displays the active target compound, the chromatogram trace to be edited for its quan-
titation and the retention time of the corresponding compound peak recognized from 
the active data file. In addition, it shows the color used for displaying the chromatogram 
trace in the Chromatogram view. In the case of a multi-component quantitation, you 
can toggle between the various target compounds using the Prev. Cmpd and Next 
Cmpd buttons.  

ISTD Compound 
Displays the ISTD compound assigned to the active target compound, the chroma-
togram trace to be edited for its quantitation and the retention time of the ISTD com-
pound peak recognized from the active data file. In addition, it shows the color used for 
displaying the respective chromatogram trace in the Chromatogram view.   

Display MS 
Note: This parameter is displayed instead of Integrate when the manual integration 
mode is not active. 

Target. Displays the averaged mass spectrum calculated for the compound peak of 
the selected target compound. 

ISTD. Displays the averaged mass spectrum calculated for the compound peak of 
the selected ISTD compound. 

Integrate 
Note: This parameter is displayed instead of Display MS when the manual integration 

mode is active. 
Target. Hides the chromatogram trace edited for the ISTD compound and displays 

the Manual Integration cursor for defining the target compound peak to be inte-
grated. 

ISTD. Hides the chromatogram trace edited for the target compound and displays 
the Manual Integration cursor for defining the ISTD compound peak to be inte-
grated. 

'Deleting peak' button 

  
Deletes the currently displayed target or ISTD compound peak.  
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'Starting and stopping manual integration mode' buttons 

    
Activates or deactivates the manual integration mode. This mode allows you to manu-
ally integrate compound peaks that were not recognized in the automatic integration 
process.  

'Toggling between files' buttons 

     
Toggles to the previous or to the next data file contained in the open batch file and 
displays the results corresponding to the currently selected target compound. 

'Toggling between target compounds' buttons 

    
Toggles, in the case of a multi-component calibration, to the previous or to the next 
target compound contained in the target compound list and displays its corresponding 
data. 

'Toggling between auto-scaling and non auto-scaling' buttons 

 Toggles between auto-scaling and non-auto-scaling of the ordinate in the Chromato-
gram view (upper button) or Spectrum view (lower button). 

 Toggles between auto-scaling and non-auto-scaling of the abscissa in the Chroma-
togram view (upper button) or Spectrum view (lower button). 
 

3.3 Calibration Window 

After you have performed a quantitation, the Calibration window displays, the calibra-
tion curve for the active target compound that was calculated from the active calibration 
points obtained for this compound. You can change the type of calibration curve to be 
calculated or deactivate particular calibration points to exclude them from being used in 
calibration curve calculation. In addition, you can change other parameters used to set 
up the calibration curve. 
Note: If you have made any changes in the parameter settings used for calculating 

the calibration curve, the corresponding data is instantly recalculated, and the 
new data is displayed both here and in the Work Table. 

In addition, if you have performed a quantitation using an ISTD compound, you can 
display the corresponding ISTD response data. 
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Figure 3-4 Calibration window after performing a quantitation: Display of calibration 

curve and ISTD data 

Calibration view 
Displays the individual calibration points for the active target compound and the result-
ing calibration curve that is calculated according to the parameters set up for the cur-
rent curve. The curve is automatically recalculated if you change one of these para-
meters.  

The calibration points are displayed as filled black points ( ) or as filled green points ( ) 
if there were multiple injections of a sample and QuantAnalysis calculates averaged 
calibration points. You can exclude a calibration point from being used in the calibration 
curve calculation by disabling it Disabled points are indicated by an open circle ( ) 
instead of the filled point. If necessary, you can re-enable a disabled calibration point 
and include it back in the calibration curve set up.  

When you move the mouse cursor near a calibration point, it changes either to  or 

to  depending on whether the point is currently enabled or disabled. Additionally, a 
data tip will appear for a few seconds displaying information about the respective cali-
bration point (calibration level, accuracy, theoretical concentration).  
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Depending on the current settings in the Calibration window, further data may be dis-
played in the Calibration view if the corresponding buttons (see below) are activated:  
- The current calibration coefficients are shown when the Show Coefficients button is 

active.  
- If you have performed a quantitation with an internal standard, the integration results 

for the ISTD compound are displayed as green squares ( ) when the Show ISTD 
Areas button is active. A green line in the middle of the view marks the averaged 
integration result. Additional green lines above and below denote the limits of single 
(‘+1σ’, ‘-1σ’) and triple (‘+3σ’, ‘-3σ’) standard deviation from the value.  
Note: It may happen that a standard deviation line is not shown since it is outside the 

view. 
- If you have defined QC samples, the corresponding results are displayed as blue 

rhombs ( ) when the Show QC Samples button is active. 
- If a QC sample is located in the batch file between the data files of calibration sam-

ples, the calibration files are separated into two blocks and QuantAnalysis calculates 
a separate calibration curve for each block separately. You can toggle between the 
different calibration curves for a target compound using the Next Block and Previous 
Block buttons, which in this case will be active.  

You can adjust the display range of the Calibration view. 

(Target compound list) 
Displays the selected target compound whose calibration data is displayed in the Cali-
bration view. In the case of a multi-component quantitation, click  to select the target 
compound whose calibration curve you wish to display from this list or use 

 and . 

(ISTD compound) 
Displays the ISTD compound assigned to the selected target compound. The calibra-
tion points calculated for this ISTD are displayed in the Calibration view as dark green 
squares.  

Curve Fit 
This parameter sets the type of calibration curve to be calculated. To change the curve 
fit, select another one from this list.  

Average RF. Mean "Response Factor" (RF).  
Linear. Linear equation.  
Quadratic. Quadratic equation.  
Cubic. Cubic equation.  

Origin 
This parameter sets how the point of origin (data point 0;0) will be included in the cal-
culation of the calibration curve. To change the mode of origin, select another option 
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from this list. 
Exclude. Calculates the calibration curve only from the data points. 
Include. Calculates the calibration curve from the data points and the point of origin. 
Force. Calculates the calibration curve from the data points and forces it through the 

point of origin. 

Weighting 
This parameter sets how the data points will be weighted in calibration curve calcula-
tion. To change the weighting of calibration points, select another option from this list. 
The following weightings are possible: None (Default), 1/X, 1/X^2, 1/Y, 1/Y^2, In-In, 
log-log.  
'Toggling between target compounds' buttons 

     
Toggles in the case of a multi-component calibration to the previous or to the next tar-
get compound in the compound list of the currently selected data file and displays the 
corresponding data. 

'Toggling between blocks' buttons 

    
Toggles in case of a multiple calibration curve setup between the calibration curves 
calculated for the previous and the next block of calibration samples for the selected 
target compound. 

'Showing specific data' buttons 
Activating one of these buttons (button becomes highlighted) results in the corre-
sponding data being displayed in the Calibration view. 

 Toggles between displaying and not displaying the current calibration 
coefficients.  

 This tool is not yet implemented. 

 This tool is not yet implemented. 

 Toggles between displaying and not displaying QC sample data. 

 Toggles between displaying and not displaying the ISTD data and 
areas. 
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'Changing scaling' buttons 

 Increases the Calibration view's ordinate and abscissa scaling by a factor of 5 
each time you click this button (e.g. if abscissa and ordinate each display a 
range from 0 to 10, then clicking this button once results in abscissa and ordi-
nate becoming re-scaled to only display a range from 0 to 2). 

 Decreases the Calibration view's ordinate and abscissa scaling by a factor of 5 
each time you click this button. 

 Resets a changed Calibration view's ordinate and/or abscissa scaling to full dis-
play of all data. 

 

3.4 Nested Display of Windows 

In the Nested display mode, the Work Table, Chromatogram/Spectrum and Calibration 
windows are nested together and displayed simultaneously. You can adjust the Nested 
display, and therefore the data currently shown, by dragging the corresponding window 
borderlines.  

Note: After the first start of QuantAnalysis, the Nested display may seem to show only 
one of these three windows. In this case, rearrange the borderlines to an 
appropriate view. 

 

3.5 Customizing the User Interface 

3.5.1 Modifying the Work Table Layout 

The layout of the Work Table can be adjusted for the kind of quantitation you wish to 
do. For example, if you want to do an external calibration you can hide all Work Table 
columns which define parameters of an internal standard. When you have optimized a 
Work Table layout for a specific kind of quantitation, you can save the modified layout 
and reload it anytime you are going to do this kind of quantitation. 
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3.5.1.1 Hiding a Work Table Column 

You can hide a Work Table column which you currently do not need for the quantitation 
you wish to perform. Using multiple selections, you can hide several columns at once. 

Note: Make sure that the columns Sample Type and Calib Level are always dis-
played. 

To hide a single column: 
1. Click on the header of the desired column. 

2. Click . 

To hide a series of neighboring columns: 
1. Hold down the Shift key and click the headers of the first and last columns in the 

desired series. Or position the mouse cursor on the header of the first column in 
the desired series and drag it, with the left mouse button held down, to the header 
of the last column. 

2. Click . 

To hide multiple individual columns: 
1. Hold down the Ctrl key and click the headers of each desired column. 

2. Click . 
 

3.5.1.2 Showing a Hidden Work Table Column 

You can show a currently hidden Work Table column again. 

To show a hidden column: 

1. Click . A drop-down field appears listing all currently hidden Work 
Table columns. 

2. Click the desired column name. This displays the respective column  
 

3.5.1.3 Changing the Width of a Work Table Column 

You can change the current width of a Work Table column e.g., if an entry is not shown 
in full length.  

To change the width of a column: 
1. Position the mouse cursor on the left or right border of the desired column head to 
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display the Column Width cursor . 
2. Drag the border with the left mouse button held down until the desired width is 

reached. 
 

3.5.1.4 Saving a Work Table Layout 

The current layout of the Work Table can be saved, e.g. after you have optimized it for 
a particular kind of quantitation. This allows you to select this Work Table layout when-
ever you want to perform this type of quantitation. Work Table layout files are saved in 
the QuantAnalysis Layout File format *.qal. 

To save the current Work Table layout: 

1. Click . This opens the Save Work Table Layout dialog for saving a 
layout file. 

2. In Save in and the folder list, navigate to that drive and folder in which you want to 
store the layout file. 

3. Depending on whether you want to save the layout under a new or an existing file 
name, do one of the following: 
• If you want to save the layout file under a new name, enter the new name in File 

name. 
• If you want to save the layout file under an existing name, select this name from 

the folder list. 
4. Click Save. 
 

3.5.1.5 Selecting a Work Table Layout 

You can select a Work Table layout suitable for the kind of quantitation you want to 
perform. This can be one of the standard layouts available for external or internal stan-
dard quantitation tasks or a self-created layout. Loading another layout changes the 
current Work Table layout according to the settings of the new layout. Work Table lay-
out files are saved in the QuantAnalysis Layout Files format (*.qal). 

To select a Work Table layout: 

1. Click . This opens the Select Work Table Layout dialog for loading a 
*.qal format file. 

2. In Look in and the folder list, navigate to the folder that contains the layout file you 
want to load. 

3. Double-click the desired layout file. Or select it and click Open.  
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3.5.2 Changing Data Display Ranges 

You can adjust the display range of the Chromatogram and Spectrum views of the 
Chromatogram/Spectrum window and the Calibration view of the Calibration window. 
 

3.5.2.1 Changing the Display Range of the Chromatogram and Spec-
trum Views 

You can adjust the display range of the Chromatogram or Spectrum view in the Chro-
matogram/Spectrum window to the optimal display of the data you are interested in.  
You can toggle the ordinate and abscissa between auto-scaling and non auto-scaling: 
auto-scaling means that the display range of an axis is automatically adjusted to dis-
play the maximum measured values. If auto-scaling is disabled, the first displayed data 
or the scaling that was used at the moment of auto-scaling deactivation specifies the 
display range for the subsequently displayed data. Whether auto-scaling of an axis is 
enabled or not, you can see from the status (highlighted or not) of the corresponding 
auto-scaling button. 
In addition, you can displace, increase or decrease the display range of ordinate or 
abscissa and, if desired, reset a changed scaling to full display of data. 

To toggle between auto-scaling and non auto-scaling of ordinate or abscissa: 

1. Click  or  that corresponds to the axis you wish to toggle to auto-scaling or 
non auto-scaling.  

To displace the display range of ordinate or abscissa: 
1. Position the mouse cursor left of the ordinate or below the abscissa to display the 

Vertical  or Horizontal  scaling cursor. 
2. Drag the cursor with the left mouse button held down either right, left, up, or down 

until the respective axis is displaced as desired. Then release left mouse button. 
During dragging, the scaling and the values displayed are continuously updated to 
show the effect of displacement.  

To increase or decrease the display range of ordinate or abscissa: 
1. Position the mouse cursor left of the ordinate or below the abscissa to display the 

Vertical  or Horizontal  scaling cursor. 
2. Drag the cursor with the right mouse button held down either downwards, to the 

left (for increasing), upwards or to the right (for decreasing), until the desired dis-
play range is reached. Then release the right mouse button. During dragging, the 
scaling and the values displayed are continuously updated to show the effect of 
the changes. 
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To reset a changed ordinate or abscissa scaling to full display of data: 
  Position the mouse cursor left of the ordinate or below the abscissa to display the 

Vertical  or Horizontal  scaling cursor and double-click the left mouse but-
ton. This resets the axis. 

 

3.5.2.2 Changing the Display Range of the Calibration View 

You can adjust the display range of the Calibration view in the Calibration window to 
the optimal display of the data you are interested in. You can change the ordinate and 
abscissa scaling either continuously by using the mouse or by predefined steps using 
the appropriate buttons. By using the mouse, you can independently adjust the display 
range of the ordinate and abscissa. 

To displace the display range of the ordinate or abscissa: 
1. Position the mouse cursor left of the ordinate or below the abscissa to display the 

Vertical  or Horizontal  scaling cursor. 
2. Drag the cursor with the left mouse button held down either to the right, left, up, or 

down until the axis is displaced as desired. Then release the left mouse button. 
During dragging, the scaling and the values displayed are continuously updated to 
show the effect of displacement.  

To continuously increase or decrease the display range of ordinate or abscissa: 
1. Position the mouse cursor left of the ordinate or below the abscissa to display the 

Vertical  or Horizontal  scaling cursor. 
2. Drag the cursor with the right mouse button held down either downwards, to the 

left (for increasing), upwards or to the right (for decreasing), until the desired dis-
play range is reached. Then release the right mouse button. During dragging, the 
scaling and the values displayed are continuously updated to show the effect of 
the changes. 

To increase or decrease the display range of ordinate and abscissa in defined 
steps: 

1. Click  to increase the display range of ordinate and abscissa by a factor of 5. 
 -or- 

 Click  to decrease the display range of ordinate and abscissa by a factor of 5. 
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To reset a changed axis scaling to full display of data: 
1 Position the mouse cursor left of the ordinate or below the abscissa to display the 

Vertical  or Horizontal  scaling cursor and double-click the left mouse but-
ton. This resets the axis. 

 -or- 

 Click . This resets both ordinate and abscissa.  
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4 CREATING AND MANAGING BATCH FILES 

4.1 Creating a New Batch File 

To perform a quantitation, first you have to create a Batch Files format file (*.btc) file, 
which must contain all the data files that have been acquired from the various calibra-
tion and "unknown" sample solutions. Optionally, a batch file can contain further data 
files from quality control and/or blank samples. Additionally, the batch file must contain 
specific information about the data files including their sample type, calibration level, 
and calibration action. 
How you create a batch file depends on how the data files to be used in quantitation 
were acquired. Data acquisition can be done within a sample table set up in either the 
Bruker Compass HyStar or the Agilent ChemStation application. In this case, you can 
import the respective sample table with automatically entering some of the data 
required for batch creation in the QuantAnalysis Work Table. Alternatively, you can use 
a series of individually acquired data files; in this case, you have to enter all data 
required manually. 
QuantAnalysis can handle data files obtained by multiple injections of the same sam-
ple. The program identifies such samples by having the same calibration level but dif-
ferent injection numbers. 
Furthermore, QuantAnalysis allows set up of separate calibration curves for different 
sample series with e.g. different matrices but the same target compound in one batch 
sequence. This requires the respective data files to be entered in the batch file as 
separate blocks. 
Once a batch file has been set up, you can create or open a quantitation method suit-
able for processing the respective batch file and then process the batch file. 
 

4.1.1 Creating a Batch File from a Sample Table 

A batch file can be created from an Agilent ChemStation sample table stored in 
Comma Separated Values Files format (*.csv) or a HyStar sample table extract stored 
in HyStar Sample Table Extract format (*.seq). You can import the respective sample 
table into QuantAnalysis, enter additional information required to perform a quantita-
tion, and save the data as a batch file (*.btc).  
You can import the sample table into a new (untitled) batch file or an existing batch file 
that already contains a sample table. In the latter case, you have the choice between 
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appending the new sample table to the existing one, and replacing the existing by the 
new one.  

Note: To import a sample table in an existing batch file the respective batch file must 
be open and unprocessed. 

 
On importing a sample table, specific information is automatically entered in the Work 
Table. This includes the names of the data files in the sample table, corresponding 
sample names, vial positions, and injection volumes. The resulting batch file automati-
cally gets a name, which depends on how the sample table is imported. If the sample 
table is imported in an existing batch file with the Append option set, the name of the 
batch file is not changed. If it is imported with the Replace option set, the batch file 
gets the name of the imported sample table with the extension changed to *btc. The 
same applies to a sample table that is imported in a new (untitled) batch file. You can 
change this name, if desired. 
To perform a quantitation QuantAnalysis needs additional information, which you have 
to enter manually, e.g., the sample type and calibration level for each data file used. 
After entering all necessary and any additional information in the Work Table, review 
the Work Table. Check that the entries in the File Name, Sample Name, Sample Info, 
Vial, Method Name, Inj. Vol., and Sample Type columns are complete. After proc-
essing the batch file these columns cannot be edited again so that changes you try to 
make in these fields will be ignored. If you notice a mistake in one of these particular 
fields after batch processing, you can reset the Work Table to the situation before 
processing. 

To create a batch file from a sample table: 
1. Click the Work Table tab to switch to full-screen display for the Work Table. 
2. Depending on whether you want to import the sample table into a new (untitled) or 

an existing batch file, do one of the following: 
• If you want to import it into a new batch file and a batch file is already open, 

select New from the File menu and, if needed, answer the pop-up confirmation 
request on saving the open batch file. This closes the respective file and clears 
the Work Table.  

• If you want to import it into an existing batch file, open the desired batch file if not 
already open. 

3. Click  to select and import the sample table from which you want to 
create a batch file.  

 This automatically enters specific information stored in the sample table into the 
File Name, Sample Name, Sample Info, Vial, Method Name, Inj. Vol, Dil Fac-
tor, Sample Type, Calib Level, Inj. No. and Calib Action columns. You have to 
check these entries and, if necessary, change them.  

4. Click  to load a Work Table layout suitable for the type of quantitation 
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you want to perform. Alternatively, adjust the current Work Table layout according-
ly.  

Tip: You can save an optimized layout using  to use it for further 
quantitations. 

5. In the Method Name column, check that a method is assigned to each data file. 
Within a batch of files, this method name must be the same for all. Change any 
differing method names.  

6. In the Inj. Vol. column, check that an injection volume is given for each sample 
that must differ from zero. Change incorrect values. 

7. In the Dil. Factor column, check that the given dilution factors differ from zero. 
Change incorrect values. 

8. In the Sample Type column, for each sample define its sample type. 
9. In the Calib Level column, for each 'Calib' or 'QC' sample define its calibration 

level.  
 In case of multiple injections of the same sample, you must assign the same cali-

bration level to these samples  
Note: In the actual software version, the concentrations belonging to the different 

calibration levels have to be defined later during creating the quantitation 
method.  

10. In the Inj. No. column, check that the given numbers differ from zero and change 
incorrect values.  

 In case of multiple injections of the same sample QuantAnalysis, on importing a 
sample table, only reads the total number of injections for the same sample and 
therefore sets all Inj. No. fields belonging to the same sample to this total number, 
e.g. '3'. You have to change these fields manually to '1', '2', and '3' for the corre-
sponding data files having the same Calib Level.  

11. In the Calib Action column, for each 'Calib' sample define its calibration action to 
be performed. Choosing New will add an additional calibration point to the calibra-
tion curve whereas choosing Replace will delete an already existing calibration 
point from the calibration curve and replace it by a new one. This latter action can 
be used in the case of multiple injections of a sample. 

12. After entering all necessary and any additional information in the Work Table, 
review the Work Table. Check that the entries in the File Name, Sample Name, 
Sample Info, Vial, Method Name, Inj. Vol., and Sample Type columns are com-
plete. After processing the batch file these columns cannot be edited anymore so 
that changes you try to make in these fields will be ignored.  
Note: If you notice a mistake in one of these particular fields after batch process-

ing, you can reset the Work Table to the situation before processing and 
repeat the respective entries.  

13. Check that all data files belonging to 'Calib' type samples are placed together 
within the sequence of the batch, as it is needed for the calibration curve setup you 
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wish to perform.  
 Please consider to the following fact: The program will calculate separate calibra-

tion curves if more than one block of 'Calib' type samples exist, separated within 
the sample by a 'Sample', 'QC' or 'Blank' type sample. This means: 
• If the calibration points from all 'Calib' type samples contained in a batch should 

be entered into one calibration curve, then all 'Calib' type samples must be 
entered as one block (e.g. see the example below: all 'Calib' samples have been 
entered as one block consisting of the rows 2 to 5). This means e.g., if you want 
to do an external calibration and you have done alternating runs of unknown and 
calibration samples you cannot enter the files in the same order as you have run 
them. Therefore, after importing the sample table you must sort all 'Calib' type 
samples within one block.  

• If more than one calibration curve should be setup for a batch, the respective 
'Calib' type samples must be placed into different blocks which must be sepa-
rated by at least one 'Sample', 'QC' or 'Blank' type sample. This will be neces-
sary e.g. if you want to quantitate different sample series with e.g. different 
matrices but the same target compound in one sample.  

 You can rearrange the data files within the sample, if necessary, by moving the 
Work Table rows accordingly. 

14. Check that within the Work Table there are no rows left blank since QuantAnalysis 
considers the first row that contains no File Name entry to be the end of the batch. 
If there are blank rows, delete them. 

15. Save the batch file using either the Save or the Save As command from the File 
menu. 
Note: Batch file saving can be performed even earlier within this procedure. In 

this case, afterwards continue filling the Work Table and save the modified 
batch file again. 

 
The following example shows an Agilent ChemStation sample table imported into 
QuantAnalysis. In the upper figure, you can see the Work Table entries automatically 
made on importing the sample table. The lower figure shows the Work Table as finally 
set up. The respective sample consists of four standard solutions containing the target 
compound, Alprazolam d0, at concentrations of 2, 10, 20, and 100 pg/µl, and the ISTD 
compound, Alprazolam d5 (penta-deuterated derivative), at a constant concentration of 
10 pg/µl. Two solutions containing 5 or 50 pg/µl d0 and 10 pg/µl d5 function as 
"unknown" samples. Additionally, three injections of a blank solution were used. 
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Figure 4-1 Work Table entries automatically filled in by importing an Agilent Chem-

Station sample table 

  
Figure 4-2 Finally set up Work Table as needed for processing the batch file created 

from the imported Agilent ChemStation sample table 
 

4.1.1.1 Importing a Sample Table 

You can import an Agilent ChemStation sample table stored in Comma Separated Val-
ues Files format (*.csv) or a HyStar sample table extract stored in HyStar Sample 
Table Extract format (*.seq) into QuantAnalysis in order to create a batch file for this 
sample.  

Note: To import a sample table into an existing batch file the respective batch file 
must be open and still unprocessed. 

To import a sample table: 
1. Depending on whether you want to import the sample table into a new (untitled) or 

an existing batch file, do one of the following: 
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• If you want to import it into a new batch file and a batch file is already open, 
select New from the File menu and, if needed, answer the pop-up confirmation 
request on saving the open batch file. This closes the respective file and clears 
the Work Table.  

• If you want to import it into an existing batch file, open the desired batch file if not 
already open. 

2. Click . This opens the Import Sample Table dialog. 
3. In Files of type, select the type of sample tables to be shown in the folder list. 
4. In Look in and the folder list, navigate to that folder that contains the sample table 

you want to import. 
5. If a batch file is open, select how to proceed with the sample table when importing 

it. This setting is of no importance if the sample table should be imported into a 
new batch file. 
• Select Append, if the imported sample table should be appended to the present 

one. 
• Select Replace, if the imported sample table should replace the present one. 

6. Double-click the desired sample table or select it and click Open.  
7. Save the resulting batch file under a desired file name. 

 

4.1.2 Creating a Batch File for a Set of Individually Acquired 
Data Files 

You can also create a batch file for a set of individually acquired data files, which must 
be contained in the same directory.  
In contrast to creating a batch file from a sample table, it is not possible to import data 
in the Work Table. Thus, you have to enter all necessary information manually. How-
ever, you can make your work easier e.g. by copying Work Table entries multiple times 
using either copy and paste or performing an 'Excel-like fill' of columns.  
After entering all necessary and any additional information in the Work Table, review 
the Work Table. Check that the entries in the File Name, Sample Name, Sample Info, 
Vial, Method Name, Inj. Vol., and Sample Type columns are complete. After process-
ing the batch file, these columns cannot be edited anymore so that entries you try to 
make in these fields will be ignored. If you notice a mistake in one of these particular 
fields after batch processing, you can reset the Work Table to the situation before 
processing. 

To create a new batch file: 
1. Click the Work Table tab to switch to full-screen display for the Work Table. 
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2. If a batch file is already open, select New from the File menu and, if needed, 
answer the pop-up confirmation request on saving the open file. This closes the 
respective file and clears the Work Table. 

3. Click  to load a Work Table layout suitable for the type of quantitation 
you want to perform. Alternatively, adjust the current Work Table layout according-
ly.  

Tip: You can save an optimized layout using  to use it for further 
quantitations. 

4. In the File Name column, enter the names of the individual data files. Make sure 
that all data files needed are copied into the same directory. 
Note: The file names must be entered together with the file extension. 

 In placing 'Calib' type samples within the sequence of a batch, please consider the 
following fact: the program will calculate separate calibration curves if more than 
one block of 'Calib' type samples exist, separated within the sequence by a 'Sam-
ple', 'QC' or 'Blank' type sample. This means: 
• If the calibration points from all 'Calib' type samples contained in a batch be 

entered into one calibration curve, then all 'Calib' type samples must be entered 
as one block (e.g. see the example below: all 'Calib' samples have been entered 
as one block consisting of the rows 1 to).  
This means e.g., if you want to do an external calibration and you have done 
alternating runs of unknown and calibration samples you cannot enter the files in 
the same order as you have run them. You must sort them accordingly.  

• If more than one calibration curve should be setup for a batch, the respective 
'Calib' type samples must be placed into different blocks which must be sepa-
rated by at least one 'Sample', 'QC' or 'Blank' type sample.  
This will be necessary e.g. if you want to quantitate different sample series with 
e.g. different matrices but the same target compound in one sample.  

 You can rearrange the data files within the sample, if required, by moving the Work 
Table rows accordingly. 

5. In the Sample Info column, enter that sample information that corresponds to the 
respective data file. 

6. In the Method name column, check that a method is assigned to each data file. 
Within a batch of files, this method name must be the same for all. Change any 
differing method names.  

7. In the Inj. Vol. column, enter the injection volumes. They must differ from zero. 
8. In the Dil. Factor column, enter the dilution factors. They must differ from zero. 
9. In the Sample Type column, select for each sample its sample type. 
10. In the Calib Level column, select for each 'Calib' or 'QC' sample its calibration 

level. In case of multiple injections of the same sample, you must assign the same 
calibration level to these samples  
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Note: In the actual software version, the concentrations that belong to the differ-
ent calibration levels have to be defined later during creating the quantita-
tion method.  

11. In the Inj. No. column, enter the corresponding injection numbers.  
12. In the Calib Action column, select for each 'Calib' sample its calibration action to 

be performed.  
13. After entering all information that is necessary, or that you want to see additionally 

in the Work Table, review the Work Table. Check that the entries in the File Name, 
Sample Name, Sample Info, Method Name, Inj. Vol., and Sample Type columns 
are complete. After processing the batch file these columns may not be edited 
anymore so that changes you try to make in these fields will be ignored.  
Note: If you notice a mistake in one of these fields after batch processing, you 

can reset the Work Table to the situation before processing and alter the 
respective entries.  

14. Check that within the Work Table there are no rows left blank since QuantAnalysis 
considers the first row that contains no File Name entry to be the end of the batch. 
Delete blank rows if existing. 

15. From the File menu, select Save As and save the entries in a new batch file. 
Note: You can save and, therefore, create the batch file even earlier within this 

procedure. In this case, afterwards continue filling the Work Table and save 
the modified batch file using the Save command from the File menu. 

  
Figure 4-3 Batch file for a set of individually acquired data files created by manually 

entering data 
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4.2 Filling and Manipulating the Work Table for a 
Batch File 

Before processing a batch file, the Work Table must be filled with all data that is 
needed for performing the respective quantitation. Which data actually has to be 
entered depends on the type of quantitation to be performed e.g. whether internal 
standards are used. 
Some data can be entered automatically when importing a sample table but all other 
data needed for quantitation must be entered manually either by typing in or selecting 
the respective data. You can manipulate the Work Table by moving or deleting rows. 
When a batch file has already been processed, you can reset the Work Table to its 
state before processing. 

 

4.2.1 Filling the Work Table Automatically 

When a sample table is imported, the program makes particular Work Table entries 
automatically. The corresponding data is stored in the respective sample table, which 
includes the names of the data files as well as the corresponding sample names, vial 
positions, and injection volumes. 
To perform a quantitation, QuantAnalysis needs additional information, which has to be 
entered manually, e.g. the sample type and calibration level, for each data file used. 

 

4.2.2 Filling the Work Table Manually 

Depending on whether you create a batch file from a sample table or for a set of indivi-
dually acquired data files you have to enter manually some data needed for quantita-
tion into the Work Table.  
Entering data manually is done by first clicking the desired Work Table field and then 
either typing in the respective data (e.g. file name, sample name, etc.) or selecting the 
desired option from the corresponding list box (in the case of sample type or calibration 
action). You can make your work easier by copying Work Table entries multiple times.  
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4.2.3 Copying Work Table Entries Multiple Times 

You can copy a Work Table entry multiple times by performing an 'Excel-like fill' of a 
Work Table column or by using copy and paste. 
Note: This 'Excel-like fill' is only active before the batch file is processed. 

To perform an 'Excel-like fill' of a Work Table column: 
1. Click the field you want to copy multiple times. 
2. Position the mouse cursor on the square in the lower right corner of the field so 

that it changes to . 
3. Drag the cursor with left mouse button held down downwards until the desired 

number of fields is reached. 
4. Release the left mouse button. The marked fields are filled according to the entry 

shown in the selected field even if the respective fields already contain entries. In 
case of the Vial column, the vial numbers will be incremented automatically. This 
is also the same for the File Name column when the selected file name contains a 
number. 

        
Figure 4-4  'Excel-like fill' of the File Name column 

To perform copy and paste: 
1. Click the field whose contents you want to copy. This selects the respective entry. 

2. Click . Or from the Edit menu, select Copy. This copies the selection and puts 
it on the Clipboard. 

3. Click the field in which you want to paste the copied entry. 

4. Click . Or from the Edit menu, select Paste. This inserts the current Clipboard 
contents in the selected field. 
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4.2.4 Moving a Row within the Work Table 

You can move a row in the Work Table up or down in order to sort the Work Table.  

To move a Work Table row: 
1. Position the mouse cursor in the number field of the row you want to move so that 

the Select Row cursor  appears and click the left mouse button. This selects the 
respective row. 

2. Position the mouse cursor on the number field and with the left mouse button held 
down drag the cursor up or down to the desired new position. During dragging, the 
current insertion position that the selected row will be moved to is indicated by a 
red line. On releasing mouse button, the row is moved to the selected new posi-
tion. 

 

  
 

  
 

  
Figure 4-5 Moving a Work Table row upwards by one position 

 

4.2.5 Deleting a Row from the Work Table 

You can delete a row from the Work Table. This must be done e.g. in case you have 
left a row blank within a batch (because the first row that contains no entry in the File 
Name field is considered to be the end of the batch), or if you have entered a sample 
by mistake which should not be contained in a batch file to be created. Using multiple 
selections, you can delete several rows at once. All entries currently contained in the 
selected row(s) are removed from the Work Table. 
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To delete a single row: 
1. In the Work Table, click the number field of the row you wish to delete. This selects 

the respective row.  

2. Click .  

To delete a series of neighboring rows: 
1. Hold down the Shift key and, in the Work Table, click the number fields of the first 

and last row in the desired series. 
 -or- 
 Position the mouse cursor on the number field of the first row in the series and 

drag it with the left mouse button held down to the number field of the last row. 

2. Click . 

To delete multiple individual rows: 
1. Hold down the Ctrl key and, in the Work Table, click the number fields of each 

desired row. 

2. Click . 
 

4.2.6 Resetting the Work Table 

The Work Table of an already processed batch file can be returned to its state before 
processing. This allows you to correct a mistake in the Work Table after processing the 
respective batch file and then repeat processing.  
When resetting the Work Table, all data entered during batch processing is cleared 
from the table and those columns that after batch processing cannot be edited any-
more are released for being edited again.  

To reset the Work Table: 

1. Click . 
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4.2.7 Defining Sample Parameters 

For performing a quantitation, you have to define specific sample parameters for the 
data files (samples) involved. First you must define the sample type, i.e. you have to 
select whether a respective data file should serve either as a sample to be quantified, 
as calibration sample, as a quality control sample or as a blank sample. Depending on 
the sample type you have assigned to a data file, you may further define the corre-
sponding calibration level and calibration action.  
 

4.2.7.1 Defining the Type of a Sample 

QuantAnalysis can handle four different sample types: 
•  'Sample' "Unknown" sample that is to be quantified. 
•  'Calib' Sample of known concentration that is used to set up a calibration curve. 
•  'QC' Quality control sample that is used to validate the calibration curve. 
•  'Blank' Blank sample that is used for system control. 

By default, the sample type is set to Sample. When you wish to assign another type to 
a sample, select it from the corresponding list.  

To select the type of a sample: 
1. In the Work Table's Sample Type column, click the field that corresponds to the 

sample whose sample type you want to define. A drop-down button appears. 
2. Click the drop-down button to open the sample type list. 

   
3. Click the desired sample type. 
 

4.2.7.2 Defining the Calibration Level of a Calibration or Quality Control 
Sample 

For a calibration ('Calib') or quality control ('QC') sample, you have to define the corre-
sponding calibration level. The program uses this level to read the corresponding con-
centrations from the table defined in the quantitation method in the Method Editor's 
Target Compounds dialog. The calibration level can be given in arbitrary units (e.g. 1, 
2, 3, ...) or in the case of quality control sample as text (e.g. low, medium, high). In 
case of multiple injections of a same sample, QuantAnalysis identifies such samples 
from the entries in the Calib Level and Inj. No. columns.  
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To define the calibration level of a sample: 
1. In the Work Table's Calib Level column, click that field that corresponds to the 

calibration or quality control sample whose calibration level you want to define 
2. Enter the desired calibration level as either arbitrary unit (1, 2, 3 ...) or text (for 

quality control samples, only). 
 

4.2.7.3 Defining the Calibration Action of a Calibration Sample 

For a calibration sample ('Calib') you have to define the corresponding calibration 
action Different types of action exist: 
•  'New' Adds an additional calibration point to the calibration curve. 
•  'Replace' Deletes an already existing calibration point from the calibration curve 

and replaces it by a new one. This action can be used in the case of 
multiple injections of a sample. 

•  '−' Performs no calibration action. This action has to be set for all non-cali-
bration samples.  

To define the calibration action: 
1. In the Work Table's Calib Action column, click the field that corresponds to the 

calibration sample whose calibration action you want to define. A drop-down button 
appears. 

2. Click the drop-down button to open the calibration action list. 

   
3. Click the desired calibration action. 
 

4.3 Saving a Batch File 

You can save a not yet processed or an already processed batch file to the Batch Files 
format (*.btc). For an unprocessed batch file, the corresponding Work Table is saved 
whereas for an already processed batch file the quantitation method used and the 
quantitation results obtained are also saved in the batch file.  
When creating a new batch file you have to save the new file. Use the Save As com-
mand from the File menu and select an already existing or a new file name. Later 
changes made to this batch file can be saved using the Save command from the File 
menu.  
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Note: The batch file must be saved in that folder that contains the data files to be 
quantified. 

Saving a batch file under a new file name will result in a subfolder with the specified 
batch file name being set up in the chosen target folder and a corresponding result file 
being saved to this batch folder. In the following, each saving operation you perform on 
this batch file will result in a new, additional result being stored to this batch file folder. 
Existing result files are not overwritten. The batch file folder contains all result files cur-
rently available for the respective batch file as well as further corresponding files.  
Automatic batch saving will be performed only before the process operation really 
starts. In case of a still unprocessed batch file, the Save Batch dialog will appear 
automatically to select a file name for saving the batch. This allows you to save the 
processed batch file under another file name while keeping the original batch file 
unprocessed. If you process an already processed batch file again, the batch file will 
automatically be saved under the same file name. Moreover, if you want to close 
QuantAnalysis or open another or a new batch file, the program will ask you about 
saving yet unsaved changes made to the currently open batch file. 

To save a batch file using a new or an already existing name: 
1. From the File menu, select Save As. 
2. In Look in and the folder list, navigate to that folder that contains the data files to 

be quantified. 
3. Depending on how you want to save the batch file, do one of the following to spec-

ify its file name: 
• To save under a new name, enter the desired name in File name. 
• To save under an existing name, enter the name in File name or select it from 

the folder list.  
4. Click Save  
5. If you have selected an already existing file name, affirm the appearing confirma-

tion request on overwriting the existing file. 
6. Completing the Save As dialog results in saving the batch file under the specified 

name. In case this dialog has appeared automatically after starting batch process-
ing, the respective batch file is first processed and then saved. 

To save a batch file using the same name: 

1. Click  or . Or from the File menu, select Save. 
 

 

 



Creating and Managing Batch Files Bruker Daltonik GmbH 

 QuantAnalysis User Manual, Version 2.0 4-16 

4.4 Opening a Batch File 

QuantAnalysis uses Windows conventions for opening batch files. You can open a 
batch file from either within QuantAnalysis or Windows Explorer. QuantAnalysis sup-
ports the drag-and-drop functionality, i.e. you can open a batch file by dragging its file 
name from Windows Explorer into the QuantAnalysis window. 
QuantAnalysis writes a new, additional result file on each saving operation you perform 
on a batch file. Thus, for each batch file one or several result files are available. If more 
than one result is available for the batch file you want to open you can select either any 
of its previously saved results or the last saved result to be loaded. Only one batch file 
can be open at a time. Loading a previous result is only possible with the Open com-
mand from the File menu. When opening a batch file from Explorer or using the File 
menu’s Recent File List always its last saved result is loaded. 
If you open an unprocessed batch file, its current processing state displays in the Work 
Table window while the Chromatogram/Spectrum window and the Calibration window 
are empty. If you open an already processed batch file, all windows automatically show 
the respective corresponding data saved in the batch file. 
Only one batch file can be open at a time. 
 
To open a batch file from within QuantAnalysis: 
1. Start QuantAnalysis. 

2. Click  or . Or from the File menu, select Open. This opens the 
Open Batch dialog. 

3. In Look in and the folder list, navigate to that folder that contains the batch file you 
want to open. 

4. Select the desired batch file from the folder list or enter its name in File name. 
5. If more than one result is available in the chosen batch file’s Result History, and if 

you do not want to load the last but a previous result, select the desired result from 
this list. Otherwise, the last result will be loaded. 

6. Double-click the desired batch file or click Open. 

Tip: You can quickly open a batch file you have recently worked with by clicking the 
respective recent file name at the bottom of the File menu. This loads the last 
saved result of the selected batch file. 

Tip: If you want to open another result of the currently open batch file you can also 
use the History button in the Work Table window to load it. 
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To open a batch file from Windows Explorer using drag and drop: 
1. Start QuantAnalysis. 
2. Start Windows Explorer. 
3. Navigate to the folder that contains the batch file you want to open. 
4. Click the desired batch file and drag it with the left mouse button held down in the 

QuantAnalysis window. Then release the mouse button. This loads the last saved 
result of the selected batch file. 

 

4.5 Showing the Result History of a Batch File 

You can show the result history for the open batch file. Depending on whether Quant-
Analysis is running in Compliance or Non-Compliance mode, the Result History dialog 
displays different information and allows for different operations. Generally, all results 
that have been saved since batch file creation are listed along with corresponding 
information about saving date and time, operator who saved as well as whether or not 
a result was deleted. When in Compliance mode, also information about already signed 
results is displayed. An arrow indicates the currently loaded result. 
From the Result History dialog, you can load or delete a certain result. When Quant-
Analysis is running in Compliance mode, you can also sign a certain result. 
 
To show a batch file’s result history: 

1. In the Work Table window, click . This opens the Result History dia-
log. 

2. To return to the Work Table window, click Close. 
 

4.6 Signing a Result of a Batch File 

When QuantAnalysis is running in Compliance mode, an electronic record (= result of a 
batch with corresponding method) of the open batch file can be signed electronically. 
Electronic signatures consist of operator ID and operator password. Only operators 
who have received from their UserManagement administrator the right to sign electro-
nic records can sign. Multiple signing of a result is allowed. 
To sign a result there is no need for the signing operator to be logged into QuantAna-
lysis. Thus, even if currently an operator who does not have the right to sign is logged 
in, signing can be performed without previous change of operator.  
Already signed results are indicated in the batch file’s result history by a ‘yes’ under 
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Signed. This applies to the Result History dialog as well as to the result history list 
displayed in the Open dialog if QuantAnalysis is currently running in Compliance mode. 
 
To sign a result of a batch file: 

1. In the Work Table window, click . This opens the Result History dia-
log. 

2. From the result list, select the result you want to sign. 
3. Click Sign. This opens the Sign Electronic Record dialog. 
4. In Operator, enter the operator ID. 
5. In Password, enter the corresponding password. 
6. In Meaning, enter the meaning of this signing, if desired. 
7. Click Sign. If operator ID and password meet, and the respective operator has the 

right to sign, the selected result is signed. The Result History dialog returns with a 
‘yes’ being entered for this result under Signed and additional information being 
shown by the Signature parameters. 

8. To return to the Work Table window, click Close. 
 

4.7 Deleting a Result from a Batch File 

Since QuantAnalysis creates and stores a new, additional result file on each saving 
operation you perform on a batch file, several results can be available for one batch file 
probably representing different states of the same batch file. Results that are not 
needed any longer can be deleted again. 
Deleted results will be listed further on in the batch files Result History dialog indi-
cated by a ‘yes’ under Deleted but will not appear any longer in the Open dialog. 
Note: When QuantAnalysis is running in Compliance mode, only an operator who has 

the respective right can perform deleting a result. 
 
To delete a result from a batch file: 

1. In the Work Table window, click . This opens the Result History dia-
log. 

2. From the result list, select the result you want to delete. 
3. Click Delete. 
4. Affirm the appearing confirmation request. This deletes the selected result and 

enters a ‘yes’ for this result under Deleted. 
5. To return to the Work Table window, click Close. 
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4.8 Showing the Audit Trail of a Batch File 

For each batch file the corresponding audit trail is recorded which could be shown 
when the batch file is open.  
The audit trail lists all changes made to the batch file with corresponding date and time, 
who (operator name) made the change and what happened. This includes all changes 
that were saved in previous processing of this batch file as well as all current changes 
already made during the running processing of this batch even if the changed state has 
not been saved yet. When the batch file is closed, only those changes that were saved 
during the running processing are stored in the audit trail. 

To show the audit trail for the open batch file: 

1. In the Work Table window, click . This opens the Audit Trail dialog. 
2. To return to the Work Table window, click Close. 
 

4.9 Closing a Batch File 

You can close an open batch file. Depending on what you intend to do hereafter there 
are several ways to close a batch file. 

To close an open batch file: 
1. To close the open batch file, you can do one of the following: 

• Click  or from the File menu, select Open if you want to open another batch 
file. 

• Click  or from the File menu, select New if you want to create a new batch 
file. 

• Click  if you want to import a sample table for creating a new batch 
file. 

• From the File menu, select Exit if you want to close the current QuantAnalysis 
session. 

2. In each case, answer the appearing confirmation request on saving the current 
processing state of the batch file to be closed.  
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5 CREATING QUANTITATION METHODS 

Batch files are processed by using a defined quantitation method which is stored in the 
QuantAnalysis part of the method embedded in the batch file.  
Methods consist of application-specific method parts. Each method contains at least 
one method part and each method part can be contained in a method only once. Often, 
methods contain several method parts e.g., for data acquisition (e.g. the esquireControl 
part) and data processing (e.g. the DataAnalysis and QuantAnalysis parts).  
To process a batch file the quantitation method needs to contain all information 
required to detect the respective target and ISTD compound peaks on the various data 
files of the batch and to calculate the corresponding quantitation results. The method 
defines the chromatogram trace(s) to be used in peak detection, the target and ISTD 
compounds present in the samples, corresponding chromatographic and concentration 
data, as well as the integration parameters to be used in peak detection and mass 
spectrum calculation.  
After editing a quantitation method, you can save the parameter settings into a new or 
an existing method. As long as you do not save the settings into a method, the settings 
will be saved only in the batch file when this is saved. Thus, saving quantitation para-
meter settings into a method allows using them for future quantitations making results 
comparable. When saving into an existing method, the previous QuantAnalysis part of 
the method will be overwritten with the new one. When saving into a new method, the 
new created method will contain the QuantAnalysis part only.  
In Compliance mode, methods can be saved as SOP or non-SOP methods (SOP = 
standard operating procedure) if the UserManagement administrator has turned on 
SOP method handling. Methods with an SOP flag cannot be modified. Only operators 
who have the special right can mark SOP methods. All operators who are allowed to 
load methods can load SOP methods but only operators with a special right can load 
non-SOP methods, too. The UserManagement administrator can define a default SOP 
method folder for saving/loading methods; in this case operators need a special right to 
use non-default method folders, too. 
 

5.1 Creating a Quantitation Method 

You can create a quantitation method to be used in processing the open batch file. 
After setting up the method, you can save it as QuantAnalysis processing part into a 
method, which allows you to use these settings in future quantitations.  
In Compliance mode, methods can be saved as SOP or non-SOP methods if SOP 
method handling is turned on. Only operators who have the special right can mark 
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methods with the SOP flag. 
A method wizard will guide you through the set up of the quantitation method. During 
set up, you have to define general quantitation parameters, the chromatogram trace(s) 
to be edited, the target and ISTD compound(s) present, corresponding chromatogra-
phic and concentration data, and the integration parameters to be used for peak 
detection and mass spectrum calculation. 

To create a quantitation method: 

1. Click   or  . Or from the Method menu, select Edit. This starts the 
Method Editor. 

2. In the General dialog, define general settings. Do the following steps: 
(a) In Default Injection Volume and Accuracy Limit [%], enter the desired 

values.  
(b) Check Apply dilution factor to ISTD compounds, if the dilution factor set in 

the Work Table's Dil. Factor column should be applied to ISTD compounds, 
too.  

(c) Check Load calibration from DataAnalysis results if the mass spectra in an 
analysis being loaded in QuantAnalysis should automatically be calibrated 
using the calibration coefficients stored in the last DataAnalysis result of the 
respective analysis.  

3. Click Next.  
4. In the Chromatograms dialog, define the chromatogram trace(s) for the com-

pound(s) to be quantified. Do the following steps: 
(a) Define a chromatogram trace by making the corresponding entries in the Type, 

Filter, of, Masses, Width, Polarity, Color, Smth Width (Gauss[sec]) and 
Cycles boxes. 

(b) Click Add. This enters the respective trace in Traces. 
(c) Repeat (a) and (b) for each chromatogram trace you want to use in peak 

detection. 
5. Click Next.  
6. In the ISTD Compounds dialog, define the ISTD compound(s) you want to use in 

the respective quantitation. Do the following steps: 
Note: If no ISTD compound is to be used, skip this dialog and continue with step 

8. 
(a) Define an ISTD compound by making the corresponding entries in Name, CAS 

No. (optionally), Chrom., Retention time [min], Window [min], Default con-
centration, and Concentration units. 

(b) Click Add. This enters the respective compound in ISTD Compounds. 
(c) Repeat (a) and (b) for each ISTD compound you want to use. 

7. Click Next.  
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8. In the Target Compounds dialog, define the target compound(s) you want to use 
in the respective quantitation. 
(a) Define a target compound by making the corresponding entries in Name, CAS 

No. (optionally), Chrom., ISTD, Retention time [min], Window [min], and 
Concentration units. In Standard conc. enter the calibration levels and cor-
responding concentrations for this target compound in the calibration samples.  

(b) Click Add. This enters the respective compound in Target Compounds. 
(c) Repeat (a) and (b) for each target compound you want to use. 

9. Click Next.  
10. In the Integration Parameters dialog, define the parameter settings to be used in 

detecting and integrating the respective target and ISTD compound peaks on the 
defined chromatogram traces as well as in calculating the corresponding mass 
spectra. Do the following steps: 
Note: Normally, the default values already allow good integration results, but if 

necessary, the parameters can be given independently for each individual 
chromatogram trace. In case there are peaks within the same chroma-
togram that differ a lot in width or intensity, it is quite often not possible to 
integrate all peaks in a correct way when using only one set of integration 
parameters. Optimizing the integration parameters then will minimize the 
need for manual integration of peaks after batch processing. 

(a) In Chromatogram, select the chromatogram trace for which you want to define 
the integration parameter settings.  

(b) Make the desired entries for the Peak detection and Mass spectrum calcula-
tion parameters.  

(c) Repeat (a) and (b) for each chromatogram trace defined. 
11. Click Finish. This closes the method editor. 
12. Save the quantitation method if you want to use its parameter settings for further 

quantitations.  
 

5.2 Saving a Quantitation Method 

 You can save a new or modified quantitation method as QuantAnalysis processing 
part into a new or existing method. When saved into an existing method, the previous 
QuantAnalysis part of the method will be overwritten by the new one. Saving into a new 
method will create a new method with only the QuantAnalysis part contained. Saving a 
quantitation method into a method allows using its parameter settings in future quanti-
tation operations. 
In Compliance mode, methods can be saved as SOP or non-SOP methods if SOP 
method handling is turned on. Only operators who have the special right can mark 
methods with the SOP flag. SOP methods cannot be modified. If a default SOP method 
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folder has been defined, the method must be saved to that default folder except the 
operator has the right to use non-default method folders. 

To save a quantitation method: 
1. From the Method menu, select Save As. This opens the Save QuantAnalysis 

Method Part As dialog. 
2. Navigate to the folder where the method should be saved. When in Compliance 

mode with SOP method handling being turned on and an SOP method folder being 
defined this must be the default folder if you do not have the right to use non-
default method folders. 

3. Depending on how you want to save the quantitation method, do one of the 
following to specify its file name:  
• To save it into the method attached to the open batch file or another existing 

method, select the respective method from the folder list or enter its name in 
Method name. This does not apply to SOP methods. 

• To save it into a new method, enter the desired new name in Method name. 
4. In Method part name, if desired, enter a name for the QuantAnalysis part. This 

can be entered in a sense of a comment. If you do not enter a name, the Quant-
Analysis part will be saved with a part name same as the method name specified. 

5. In Comment, if desired, enter a comment for the method. This comment applies to 
the entire method, not only to the QuantAnalysis part. 

6. When in Compliance mode with SOP method handling being turned on: Check the 
SOP method box if you want to save the method with the SOP flag. This is only 
allowed if you have the right to mark methods as SOP. 

7. Click Save. 
8. If you have chosen an existing file name, confirm the appearing request to over-

write the QuantAnalysis part of the original method. 
 

5.3 Opening a Quantitation Method 

You can open a quantitation method and attach it to the loaded batch file. This 
overwrites the QuantAnalysis processing part of the method currently embedded in the 
batch file.  
When in Compliance mode with SOP method handling being turned on, all operators 
can load SOP methods but only operators who have a special right can load non-SOP 
methods, too. If a default SOP method folder has been defined, only methods placed in 
that default folder can be loaded except the operator has the right to use non-default 
method paths, too. 
You can view the parameters settings of the open quantitation method after starting the 
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method editor.  

 

To open a quantitation method: 

1. Click . Or from the Method menu, select Open. 
2. Navigate to the folder that contains the method with the desired QuantAnalysis 

part. When in Compliance mode with SOP method handling being turned on and 
an SOP method folder being defined, you can only load a method placed in that 
default folder if you do not have the right to use non-default method folders. 

3. Select the method or enter its name in Method name. 
4. Click Open. 
 

5.4 Viewing a Quantitation Method 

The current parameter settings of the open quantitation method can be viewed in the 
Method Editor.  

To view a quantitation method: 
1. Open the quantitation method you want to view. 

2. Click   or  . Or from the Method menu, select Edit.  
3. Click Next or Back to browse through the method editor's dialogs and view the 

current parameter settings. 
4. Click Finish to close the method editor. 
 

5.5 Modifying a Quantitation Method 

You can modify a quantitation method according to your needs by changing its current 
settings. When finished, the modified method can be saved as QuantAnalysis part into 
a new or an existing method. 
When in Compliance mode with SOP method handling being turned on you cannot 
modify methods for which the SOP flag is set. Modification is only possible after the 
SOP flag has been cleared. This can be done by saving the method without the SOP 
method option being set using the same file name. 

To modify a quantitation method: 
1. Open the quantitation method you want to modify. 
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2. Click  or . Or from the Method menu, select Edit. This starts the 
method editor and opens the General dialog. 

3. Click Next (and/or Back) to reach the dialog whose current settings you want to 
change.  

4. Change the current settings as required. 
Note: Take care, that changes you have made in the Chromatograms, ISTD 

Compounds, or Target Compounds dialogs must be entered by clicking 
the appropriate button (Change or Add) before leaving the respective dia-
log by clicking Next or Back. Otherwise, these changes will be lost. 

5. Click Finish when you have finished modifying the respective method.  
6. Save the modified quantitation method. 
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6 PROCESSING BATCH FILES 
After creating a batch file and defining the quantitation method to be used with this 
batch file you can process the respective batch files. Processing a batch file means 
that the data files (analyses) contained in this batch are processed according to the 
parameter settings defined in the selected quantitation method and that the concen-
trations of the specified target compounds are calculated from the calibration curves 
set up.  
• When processing starts, QuantAnalysis first evaluates the information and gives an 

error message if important information is missing. 
• After evaluation, the data files are loaded and analyzed. If the Load calibration from 

DataAnalysis results option is set in the method used, the mass spectra in the 
loaded analyses will be calibrated using the calibration coefficients stored in the 
respective last DataAnalysis result. 

• The chromatogram traces specified in the Method Editor's Chromatograms dialog 
are created for each data file. 

• Compound peaks are detected and integrated according to the settings in the 
Method Editor's Target Compounds, ISTD Compounds and Integration Parame-
ters dialogs. 

• Calibration curves are calculated using the calibration levels set in the Work Table 
and the corresponding target compound standard concentrations defined in the 
Target Compounds dialog.  

• From these calibration curves, the target compound concentrations of the unknown 
'Sample' samples are calculated and entered in the Work Table. 

A blue bar at the bottom of the screen shows the progress of this process. The entire 
process usually takes only a few seconds. 
The quantitation results are automatically saved during data analysis. You can review 
the quantitation results and, if required, alter them e.g., by modifying calibration curves 
or manually integrating compound peaks. You can plot particular quantitation data, 
print specific quantitation reports and export quantitation data to use them in other 
applications. 
 

6.1 Processing a Batch File 
You can process the open batch file according to the current parameter settings 
defined in the selected quantitation method and save the quantitation results and the 
method used with the respective processed batch file.  
When starting batch processing, the respective batch file is automatically saved before 
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processing starts. For a yet not processed batch file, the Save As dialog will appear 
which allows you to save the processed batch file under a new file name and, thus, 
keep the original batch file unprocessed for performing further processing operations 
on it, e.g. by using another quantitation method. For an already processed batch file no 
saving dialog will appear. 
Processing a batch file usually takes only a few seconds. A blue bar at the bottom of 
the screen shows the progress of this process. After processing is finished, you can 
review the quantitation results obtained. 

To process a not yet processed batch file: 
1. Open the unprocessed batch file you want to process. 
2. Open the quantitation method you want to use or create a new method. 

3. Click . 
4. In the appearing Save As dialog, select or enter the file name the processed batch 

file should be saved with  
Note: The batch file must be saved in that folder that contains the data files to be 

quantitated. 
Note: This dialog will appear only on processing a not yet processed batch file. 

5. Click Save. This starts batch processing. 
6. Save the processed batch file. 

To reprocess an already processed batch file: 
1. Open the processed batch file you want to reprocess. 
2. Open the quantitation method you want to use or create a new method. 

3. Click . This starts batch processing. 
4. Save the processed batch file. 
 

6.2 Calculation of Calibration Curves 

Calibration curves will be calculated using the following formulas: 
 
Calculation of the theoretical concentration 
The theoretical concentration is calculated using the following formula: 

DefInjVol
InjVol

DilFactor
ConcConc Leveltheor ⋅⋅=

1

 
with: 
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theorConc : theoretical concentration, calculated and displayed in the Work Table. 
LevelConc : standard concentration for this level of the target compound entered in the 

quantitation method. 
DilFactor : dilution factor entered in the Work Table. 
InjVol : injection volume for this analysis entered in the Work Table. 
DefInjVol : default injection volume entered in the quantitation method. 
 
Calculation of the internal standard concentration 
The concentration of the internal standard is calculated in the same way. The dilution 
factor is applied only if it is enabled in the quantitation method. This will result in the 
following X, Y pairs shown in the calibration plot: 

( )AreaConctheor ,  resp. 
⎟⎟
⎠

⎞
⎜⎜
⎝

⎛

ISTD

etT

ISTD

theor

Area
Area

Conc
Conc arg,

 with internal standard calculation. 

For calibration mode height (instead of area) the calibration is performed equivalently. 
 
Calculation of the calibration curve  
The calibration curve is calculated using these X, Y pairs, resp. the average value for 
the same. 
Weighting is applied in the calculation of the calibration curve by applying the inverse of 
the weight factor as standard deviation at each individual point. 
 
Calculation of the concentration of an unknown sample 
The concentration of an unknown sample is calculated by solving the calibration curve 
with the area, respectively the height, of the peak. Then the dilution factor and injection 
volume is applied using the above equation. 
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7 REVIEWING CALIBRATION AND 
QUANTITATION RESULTS 

For reviewing calibration and quantitation results, we recommend that you switch to the 
Nested display. This shows all results simultaneously displayed in the Work Table win-
dow, Chromatogram/Spectrum window and Calibration window.  
Note: If necessary, adjust the relative size of the windows by dragging the respective 

window borders. 
 

  

Figure 7-1 Quantitation results obtained for a batch file created from an Agilent 
ChemStation sample table 
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7.1 Determining Which File or Target Compound is 
Currently Active 

One of the lines in the Work Table is highlighted in green to indicate that the respective 
data file is the "active" (selected) one. The respective Data File name is also displayed 
at the top of the Chromatogram/Spectrum window.  

The active target compound is shown in  found 
in the Work Table as well as under Target Compound in the Chromatogram/Spectrum 
window and in the corresponding list box of the Calibration window. 
The Chromatogram/Spectrum window will display the chromatogram peak and mass 
spectrum that corresponds to the currently selected ("active") target compound of the 
"active" data file. It also displays the respective ISTD compound peak if an internal 
standard was assigned to this target compound. The Calibration window shows the 
calibration curve that was calculated for the selected target compound along with cor-
responding ISTD and quality control data provided such data are present and their dis-
play is activated. 
 

7.2 Toggling Between Different Files and Target 
Compounds 

You can toggle between different data files or different target compounds. The one 
currently selected is the "active" one whose corresponding data is displayed. 

Use  and  from either the Work Table window or the Chromatogram/Spec-
trum window to toggle between different data files.  

Use  and  from either the Work Table window, Chromato-
gram/Spectrum window or Calibration window to toggle between different target com-
pounds.  

Alternatively, you can use  from the Work 
Table window to select the desired target compound directly. This is helpful in cases 
where the quantitation contains many compounds. 
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7.3 Viewing the Quantitation Data for a Target 
Compound 

The quantitation data obtained for a target compound is listed in the corresponding 
columns of the Work Table window. This includes the retention times and areas of the 
target compound peaks, and the calculated concentrations and the accuracy values for 
the calibration samples. In case of a quantitation with an internal standard, the areas of 
the ISTD compound peaks and the area ratios of target and ISTD compound peaks are 
also given.  

In some instances, no entries are made in one of the data file rows for the calculated 
area, concentration and accuracy for a selected target compound. This indicates that 
the respective target compound or corresponding ISTD compound was not found in the 
peak integration operation, and the corresponding values could not be calculated. If 
this occurs, try to integrate the respective compound manually.  
Area values for manually integrated compounds display in blue, accuracy values, which 
lie outside the specified accuracy limit, display in red. 
The quantitation data displayed in the Work Table are automatically recalculated when 
the corresponding calibration curve is altered or a target or ISTD compound peak is 
manually integrated. You can plot specific quantitation data obtained for the data files 
of a batch. 
 

7.4 Viewing the Peak Integration Results for a 
Target Compound 

The peak integration results for the selected target compound of the active data file and 
the calculated corresponding mass spectrum are displayed in the Chromatogram/Spec-
trum window.  
If an internal standard was assigned to the target compound, its corresponding peak is 
also shown in the Chromatogram view. For viewing the corresponding mass spectrum, 
you have to select the ISTD for Display MS. 
Note: We recommend that you check the peak integration results for improperly inte-

grated peaks. Give special attention to chromatogram traces of the 'Sample' 
type. If necessary, correct the integration of a target or ISTD compound peak in 
the manual integration mode. 
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7.5 Viewing the Calibration Curve for a Target 
Compound and Corresponding ISTD and Qua-
lity Control Data 

The calibration curve for the selected target compound is displayed in the Calibration 
window.  

You can display additional information by activating the following buttons: 

 Shows the ISTD areas if an internal standard was assigned to the 
selected target compound. 

 Shows quality control samples provided such samples have been 
defined. 

 Shows the curve coefficients for the calculated calibration curve. 

When setting up multiple calibration curves, use  and  to 
toggle between the calibration curves that were calculated for the previous block and 
the next block of calibration samples for the selected target compound. 
You can alter the calculated calibration curve for a target compound by disabling cali-
bration points as well as with respect to its curve fit, mode of origin and/or weighting of 
calibration points. Each of these changes will result in recalculating the calibration 
curve immediately and redisplaying it. The corresponding quantitation data listed in the 
Work Table are recalculated accordingly. 
 

7.6 Plotting Quantitation Data 

You can plot specific quantitation data obtained for the individual data files of a batch 
file by plotting the contents of the corresponding Work Table column. This function is 
restricted to specific columns. 
 
To plot the contents of a Work Table column: 
1. Click the header of the desired Work Table column (e.g. Cal. Conc.). 

2. Click . The Plot Column window appears displaying the respective plot. 
3. To change the current plot type, click the desired option Bar, Line or Area. 
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4. Click Close to close the current plot. 
 

  

Figure 7-2 Plot of target compound concentrations calculated for the data files inves-
tigated with the concentrations displayed as bars 
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8 ALTERING QUANTITATION RESULTS 

You can alter the quantitation results obtained after a batch file was processed. This 
can be done by manually integrating or deleting target or ISTD compound peaks. This 
can be done also by altering calculated calibration curves e.g. by deactivating calibra-
tion points, or by changing their weighting, changing the curve fit, or mode of origin. 
Each of these changes will result in recalculating the corresponding quantitation results 
listed in the Work Table. Furthermore, you can reprocess an already processed batch 
file e.g. with using another quantitation method. 
 

8.1 Integrating a Compound Peak Manually 

You can manually integrate a target or an ISTD compound peak which has not been 
recognized during the automatic integration process performed on the corresponding 
chromatogram or which has been improperly integrated. A compound peak that has not 
been recognized during automatic integration is indicated in the Work Table by its cor-
responding Area (or Height) Target (or ISTD) Cmpd field being left empty. 
When the Manual Integration mode is active, manual integration can be performed in 
the chromatogram view of the of Chromatogram/Spectrum window. The corresponding 
quantitation results are immediately updated in the other windows. Compound peak 
areas that were obtained through manual integration are displayed in blue in the Work 
Table. 

To manually integrate a compound peak: 
1. Click the Chromatogram/Spectrum tab to switch to full-screen display for the 

Chromatogram/Spectrum window. 

2. Click  to activate the Manual Integration mode. This can 
result in the following: 
- In the case of a quantitation with internal standard, the chromatogram trace cur-

rently not selected in Integrate (Target or ISTD) is not displayed. If you wish to 
integrate this hidden chromatogram, click the corresponding option to display it 
and hide the other one. 

- For an already integrated peak, its current start and end positions are indicated 
by two handles.  

3. Select the data file containing the compound peak to be integrated by clicking 

 or . The currently active data file is shown right beside File name.  
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4. Select the compound whose peak you wish to integrate by clicking  

or  if there is more than one target compound. The currently active 
target compound is shown in Target Compound, the corresponding ISTD com-
pound, if available, in ISTD Compound. This displays the corresponding chroma-
togram trace(s) edited for this/these compound(s) in the chromatogram view. 

5. Adjust the display range of the chromatogram view to display the peak you are 
interested in. 

6. Depending on whether or not the peak you wish to integrate has already been 
integrated proceed as follows: 
• In the case of an already integrated peak, position the mouse cursor near (3 

pixel) to the handle whose position you want to change so that it changes to . 
Then drag the respective handle with the left mouse button held down to the 
desired position (data point) and release the mouse button. If desired change the 
position of the second handle, too.  

     
Figure 8-1 Integrating a compound peak manually 

• In the case of an unintegrated peak, position the mouse cursor at the beginning 
of the peak and click the left mouse button. This causes two peak handles to be 
displayed. Then drag these handles to desired positions as described above. 

 The (new) calculated peak area is automatically entered in the corresponding 
Work Table field. 

7. Repeat steps 3 to 6 for all peaks you want to integrate manually. 

8. Click  to deactivate the Manual Integration mode. The 
peak handles will disappear and a hidden chromatogram trace is redisplayed. 

9. Save the processed batch file that you have changed, if desired. 

8.2 Deleting a Compound Peak 

You can delete a target or ISTD compound peak from the open batch file. This 
removes the corresponding data from the Work Table and, therefore, from being used 
in quantitation. On deleting a peak, all corresponding quantitation results are imme-
diately updated in the other windows. 
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Tip: If you have deleted a compound peak from a batch file, you can include it again 
in quantitation by integrating it manually. This will add the peak again. 

To delete a compound peak: 
1. Click the Chromatogram/Spectrum tab to switch to full-screen display for the 

Chromatogram/Spectrum window. 
2. Select the compound peak you want to delete by displaying it in the chromatogram 

view. For this, use ,  ,  or . 

3. Click . This opens the Confirm Delete dialog. 
4. In the case of a quantitation with internal standard, select which peak, the Target 

Peak or the ISTD Peak, you want to delete. 
5. Click OK.  
6. Repeat steps 2 to 5 for all compound peaks you want to delete. 

 

8.3 Altering a Calibration Curve 

You can alter a compound’s calibration curves in several ways. Altering the calibration 
curve, such as by disabling single calibration points or changing its origin, automatically 
results in recalculating and redisplaying the curve. The corresponding quantitation 
results are displayed immediately in the Work Table, which is updated accordingly. 
 

8.3.1 Disabling a Calibration Point 

You can disable individual calibration points on the calibration curve to exclude them 
from the calibration curve calculation. An enabled calibration point is displayed as a 
black point ( ) or in case of an average value from multiple injections as a green point 
( ). In the latter case you must disable all calibration points of the respective level indi-
vidually. 

To disable a calibration point: 
1. In the Calibration window, display the calibration curve you want to alter. To do 

this, select the respective target using  and . In case of 
a multiple injection quantitation, additionally select the respective calibration block 

using  and . 
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2. Move the mouse cursor near to the calibration point (  or ) you want to disable so 

that it changes to . 
3. Click the left mouse button. The black point will turn into an open circle ( ).  
4. Save the changed processed batch file, if desired. 
 

8.3.2 Enabling a Calibration Point 

You can re-enable a disabled calibration point and include it again in the calibration 
curve calculation. A disabled calibration point is indicated by an open circle ( ). 

To enable a disabled calibration point: 
1. In the Calibration window, display the calibration curve you want to alter. To do 

this, select the respective target using  and . In case of 
a multiple injection quantitation additionally select the respective calibration block 

using  and . 
2. Move the mouse cursor near the desired disabled calibration point ( ) so that it 

changes to . 
3. Click the left mouse button. The open circle will turn into a filled black point ( ).  
4. Save the changed processed batch file, if required. 
 

8.3.3 Changing the Curve Fit of a Calibration Curve 

You can alter the calibration curve for the selected target compound by changing the 
Curve Fit currently selected. You can choose between Linear, Average RF, Quadra-
tic or Cubic curve fit. 

To change the curve fit of a calibration curve: 
1. In the Calibration window, display the calibration curve you want to alter. To do 

this, select the respective target using  and . In case of 
a multiple injection quantitation, additionally select the respective calibration block 

using  and . 
2. From the Curve Fit list box, select the desired fit. 
3. Save the changed processed batch file, if desired. 
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8.3.4 Changing the Mode of Origin of a Calibration Curve 

You can alter the calibration curve for the selected target compound by changing the 
Origin currently selected. You can select between Exclude, Include or Force. 

To change the mode of origin of a calibration curve: 
1. In the Calibration window, display the calibration curve you want to alter. To do 

this, select the respective target using  and . In case of 
a multiple injection quantitation, additionally select the respective calibration block 

using  and . 
2. From the Origin list box, select the desired mode of origin. 
3. Save the changed processed batch file, if desired. 
 

8.3.5 Changing the Weighting of Calibration Points 

You can alter the calibration curve for the selected target compound by changing the 
Weighting currently selected. You can choose between different types of weighting. 

To change the weighting of calibration points of a calibration curve: 
1. In the Calibration window, display the calibration curve you want to alter. To do 

this, select the respective target using  and . In case of 
a multiple injection quantitation, additionally select the respective calibration block 

using  and . 
2. From the Weighting list box, select the desired weighting. 
3. Save the changed processed batch file, if desired. 
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9 PRINTING AND SENDING REPORTS 

Several standard report layouts for printing specific quantitation data are available. 
They are installed on your system automatically when you install QuantAnalysis. You 
can use these default layouts or you can also create your own layouts using the Bruker 
Compass ReportDesigner. You can preview a report before printing it to allow you to 
decide whether to print it. In addition, you can send a report as an email to a recipient 
or save it as PDF document. 

Support for printing on older printer models 
With older printer models (with insufficient firmware performance), there might be the 
problem that printing of a report takes a very long time. To overcome this, a registry 
switch now supports faster printing on printers with insufficient firmware performance.  
 

9.1 Printing a Report w/o Previewing 

You can print a quantitation report. Several standard report layouts for printing specific 
quantitation data are available. All layouts can be printed in portrait and landscape for-
mat. Before printing a report, you can preview it. This allows you to first look at the 
respective report and then to decide whether it should be printed. 

To print a report w/o previewing it: 

1. Click . This opens the Print dialog. 
2. In Name, select the printer you want to use. 
3. Click Properties and select in Orientation the format (Portrait or Landscape) you 

want to use for printing. If needed, change page set up options. Then click OK. 
Note: The options available depend on the selected printer. 

4. In Instrument, the instrument used is selected by default. If you want to select a 
report layout appropriate for another instrument, uncheck Select automatically 
and select the desired instrument.  

5. In Layout, select the layout for the report you want to print. 
6. If you wish to preview the report before printing it, click Preview.  
7. To print the report, click OK in the Print dialog, or if in the preview, click the pre-

view’s . This prints the report on the selected printer. 
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9.2 Setting a Registry Switch for Faster Printing on 
Older Printer Models 

With older printer models, there might be the problem that printing of a report takes a 
very long time since the printer firmware is too slow when converting the vector graphic 
into a bitmap graphic. To overcome this problem a registry switch is now available 
which lets DataAnalysis create the bitmap already and thus speeds up printing on such 
printers. 
Note: NT administrator privileges are required for setting the registry key. 

To set a registry key for faster printing: 

1. Click . 
2. Click Run. This opens the Run dialog. 
3. In Open, type in "regedit" and click OK. This opens the Registry Editor. 
4. Navigate to "Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Bruker Daltonik".  
5. Right-click the key "Bruker Daltonik" and from the context-sensitive menu (CSM) 

select New > Key. Overwrite the default key name with "Printers". 
6. Right-click the key "Printers" and from the CSM select New > Key. Overwrite the 

default key name with the name of the printer for which you want to set the registry 
key, e.g. "HP LaserJet 5000 Series PCL". 
Note: The proper printer name is best taken from the QuantAnalysis Print dialog. 

Let’s assume a network printer is listed thereof as “\\MyServer\My-Printer”. 
The key name used in the registry then must be: “||MyServer|My-Printer”, 
replacing back slashes (‘\’) with vertical bars (‘|’). 

7. Right-click the key "[printer name]" and from the CSM select New > DWORD 
Value. This enters a double word (dword) value for the key "[printer name]" which 
is specified by the Name "New Value #1", the Type "REG_DWORD" and the Data 
"0x00000000 (0)". Overwrite the default name with "UseBitmaps". 

8. Right-click the name "UseBitmaps" and from the CSM select Modify. In the Edit 
DWORD Value dialog, change the current Value data value from "0" to "1" and 
click OK. This changes the "UseBitmaps" value accordingly and thus switches the 
key on. 

9. Close the Registry Editor. 
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Figure 9-1 Example registry key for faster printing on the named printer 
 

9.3 Sending a Report as an Email 

You can print a selected report to a PDF file and send this automatically as an attach-
ment of an email to a specified email address. If desired you can preview the report 
(Section 9.1) before sending it. 

To send a report as email: 
1. From the File menu, select Send To and then Mail Recipient. This opens the 

Send To Mail Recipient dialog. 
2. In Email Address, enter the email address of the recipient to whom you want to 

send the report. 
3. In Name, select the printer you want to use. 
4. Click Properties and select in Orientation the format (Portrait or Landscape) you 

want to use for printing. If needed, change page set up options. Then click OK. 
Note: The options available depend on the selected printer. 

5. In Instrument, the instrument used is selected by default. If you want to select a 
report layout appropriate for another instrument, uncheck Select automatically 
and select the desired instrument.  

6. In Layout, select the layout for the report you want to preview. 
7. Click Send. This opens the Choose Profile dialog. 
8. In Profile Name, select the profile you want to use. If desired, create a new profile 

and/or set advanced logon options. 
9. Click OK. This creates the selected report and sends it to the specified email 

address. If no email address is specified, the email program will prompt for it. 
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9.4 Sending a Report to a PDF Document 
You can print a selected report to a PDF file and save it to a chosen target folder. If 
desired you can preview the report (Section 9.1) before saving it as PFD document. 

To save a report as PDF document: 
1. From the File menu, select Send To and then PDF Document. This opens the 

Send To PDF Document dialog. 
2. In PDF file name, enter path and name for the PDF document to be saved. To 

enter the path, you can click  and select the target folder using the appearing 
dialog. 

3. In Name, select the printer you want to use. 
4. Click Properties and select in Orientation the format (Portrait or Landscape) you 

want to use for printing. If needed, change page set up options. Then click OK. 
Note: The options available depend on the selected printer. 

5. In Instrument, the instrument used is selected by default. If you want to select a 
report layout appropriate for another instrument, uncheck Select automatically 
and select the desired instrument.  

6. In Layout, select the layout for the report you want to preview. 
7. Click Save. This saves the PDF document with the specified file name in the cho-

sen target folder. 

9.5 Creating a Custom Report Layout 

The Bruker Compass ReportDesigner application allows you to create your own report 
layouts for printing specific reports. You can either modify an existing report layout 
available on your system or set up a completely new layout. For help on creating report 
layouts, please refer to the ReportDesigner Help. 
Note: It is recommended not to modify the standard layout but to save the modified 

layout under a new file name. Otherwise, there is a risk that your changed stan-
dard layout version may be overwritten by a later system upgrade. 

To start ReportDesigner: 

1. Click . This opens the Print dialog. 
2. In Report Layout, select the layout based on which you want to create a new 

layout. Alternatively, you can select the respective layout in ReportDesigner after 
it is started. 

3. Click ReportDesigner. This starts ReportDesigner and loads the layout currently 
selected in Layout. 
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10 EXPORTING BATCH FILES 

You can export the data in the open batch file in Comma Separated Values Files for-
mat (*.csv) to allow you to load the file in Microsoft Excel. The data actually exported 
depends on whether the respective batch file has already been processed. Processed 
batches are exported in the form of results tables while in unprocessed batches, the 
sample table is exported as *.csv file. 

To export a batch file: 

1. Click . This opens the Export Sample Table dialog for exporting a 
Comma Separated Values file (*.csv ). 

2. In Save in and the folder list, navigate to that folder the batch file should be 
exported to. 

3. In File name, enter the name of the file you want to export. 
4. Click Save. 
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A APPENDIX 

A.1 QuantAnalysis 2.0 Toolbar 

QuantAnalysis 2.0 provides the following tool buttons: 
Button Menu - Command Shortcut Used to… 

  
File – New Ctrl+N Create a new batch 

 
File – Open  Ctrl+O Open an existing analysis.  

  
File – Save  Ctrl+S Save active batch using the same file name. 

  
Edit – Cut Ctrl+X Cut the selection and put it on the Clipboard. 

  
Edit – Copy Ctrl+C Copy the selection and put it on the Clipboard. 

  
Edit – Paste Ctrl+V Insert the Clipboard contents. 

  
Method – Open  Open and attach quantification method. 

 
Help – Help Topics  Start QuantAnalysis help and list help topics. 

 

A.2 QuantAnalysis 2.0 Menus and Commands 

QuantAnalysis 2.0 provides the following menus and commands: 
File menu Commands  Used to… 

  

New 
Open 
Save 
 
Save As 
 
Send To popup 
Recent files 
Exit 

 

Create a new batch. 
Open an existing batch.  
Save the active batch using the 

same file name. 
Save the active batch using 

another file name. 
Send report. 
List the last processed batches. 
Close QuantAnalysis.  
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View menu Commands  Used to… 

  

Toolbar 
Status Bar 

 

Show or hide toolbar.  
Show or hide status bar. 

 

Edit menu Commands  Used to… 

  

Undo 
Cut 
 
Copy 
 

Paste 

- not yet implemented - 
Cut the selection and put it on the 

Clipboard. 
Copy the selection and put it on 

the Clipboard. 
Insert the Clipboard contents. 

Method menu Commands  Used to… 

  

Open 
 
Save As 
Edit 

 

Open and attach a quantification 
method.  

Save quantification method. 
Edit parameters of open quanti-

fication method. 

Compass menu Commands Used to… 

 

Compass Desktop Launch Compass Desktop. 

Help menu Commands  Used to… 

 

Help Topics 
License 
Operator 
Lock All 

Applications 
About Compass 

QuantAnalysis 

Launch QuantAnalysis help. 
Show license information.  
Log in specified operator.  
Lock all Bruker Daltonics appli-

cations. 
Show program information.  

 
 

 
 
 
 
 
 
 
 
 
 



Bruker Daltonik GmbH Appendix 

QuantAnalysis User Manual, Version 2.0  A-3

A.3 QuantAnalysis 2.0 Shortcuts 

QuantAnalysis 2.0 provides the following shortcuts: 
Shortcut Menu - Command Used to… 
Alt+F4 File – Exit  Close QuantAnalysis. 
Ctrl+Alt+K Help – Lock All Applications Lock all Bruker Daltonics applications. 
Ctrl+C Edit – Copy Copy the selection and put it on the Clipboard.
Ctrl+N File – New Create a new batch. 
Ctrl+O File – Open Open an existing batch. 
Ctrl+S File – Save Save the active batch using same file name. 
Ctrl+V Edit – Paste Insert the Clipboard contents. 
Ctrl+X Edit – Cut Cut the selection and put it on the Clipboard. 
Ctrl+Z Edit – Undo - not yet implemented - 
F1 Help – Help Topics Launch QuantAnalysis help. 
F11 Compass – Compass Desktop Launch Compass Desktop. 
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